Connect
Information Technology at NYU
Volume 15, Number 1
Fall/Winter 2004

Also in this issue: Building Residence Hall Community • Phishing Attacks
What’s New with NYU Blackboard • How to Download Your NYUHome E-mail
Recommended Reading for SAS & SPSS • The 2004 Geospatial Summer Symposium
Welcome to the Fall/Winter 2004 edition of Connect!

Another exciting academic year is underway and, as usual, Connect’s contributors have been busy with a variety of ambitious projects and initiatives: ITS recently implemented NYU SafetyNET, a network security service that helps protect the computers of ResNet residents; NYU was honored with two Library of Congress grants to help fund collaborative digital preservation initiatives; the Department of Residential Education and SCPS each introduced innovative uses of Blackboard to help build community and enhance education; NYU hosted a very successful geospatial symposium; and Bobst Library completed the first phase of a major renovation project.

Alongside the interesting articles about these achievements, this issue contains helpful information for GIS, SPSS, and SAS programmers, for instructors who wish to expand their use of technology in the classroom, for people who would like to download copies of their NYUHome e-mail to their computer, and for designers who’d like to gain a better understanding of color management. Many thanks to all of our contributors, and I hope that you all will enjoy this issue as much as I have.

- Kate Monahan

About Connect

Connect: Information Technology at NYU is edited and published by Information Technology Services (ITS). Its scope includes information about computing, networking, and telecommunications across NYU’s various schools, departments, and administrative units, as well as developments in information technology outside the University.

Print copies of Connect are available at the ITS Faculty Technology Center, the ITS computer labs, the ITS Client Services Center, the NYU Information Center, and most graduate school offices. Copies are mailed to full-time University faculty, staff, administrators, and researchers, based on mailing lists administered by the Human Resources Division. Current and past issues of Connect are also available on the Web at http://www.nyu.edu/its/pubs/connect/.

If you are a full-time faculty member and do not receive a copy, please notify your dean’s office; full-time staff should notify their human resources representative. If you are not among these groups but would like a free subscription, please send e-mail to its.connect@nyu.edu.

We welcome your comments about the articles in this issue, as well as suggestions for future issues. Contributions are invited for consideration by the editor.

Opinions expressed in the articles in this publication are those of the authors and not necessarily those of Information Technology Services or of New York University.

Editor

Kate Monahan
kate.monahan@nyu.edu

The Editor gratefully acknowledges the invaluable editorial support of her colleague, Jill Hochberg.

Contributors

David Ackerman,
Lucy Appert,
Robyn Berland,
Lucinda Covert-Vail,
Ethan Ehrenberg,
Frank LoPresti,
Antonio Lopez,
Tracey Losco,
Tom McNulty,
Alexandre de Miranda,
Lance Morrow,
Phil Rodrigues,
Gloria Rohmann,
Victor Santana III,
Shelly Smith,
Yakov Smotritsky,
Robert Squillace,
Maurice Washington,
and Robert Whelan.

Thanks also to...

Will Arnold, Dan Berger,
Doug Carlson, Eduardo DeLeón,
Jane DelFavero, Vincent Doogan,
Jeffrey Lane, Ben Maddox, Carol Mandel,
Marilyn McMillan, and Erin O’Malley.

http://www.nyu.edu/its/pubs/connect/
Copyright © 2004 New York University.
Contents • Fall/Winter 2004

Residence Life
- Building Residence Hall Community, Friendships & Learning with Web Tools
  By Maurice Washington, Lance Morrow & Alexandre de Miranda .............. 2

Computing in the Arts
- The Media Matrix
  Improving Arts Education at SCPS
  By Lucy Appert, Ethan Ehrenberg, Gloria Rohmann & Robert Squillace .......... 6

- A Basic Guide to Color Management
  By Shelly Smith ...................... 31

Computer & Network Security
- NYU SafetyNET
  Building a Self-Defending Network
  By Phil Rodrigues ................... 11

- Phishing Attacks
  Don’t Let them Reel You In!
  By Tracey Losco ...................... 25

Online Learning
- What’s New with NYU Blackboard?
  By Ethan Ehrenberg ................. 14

NYU Libraries
- Bobst Library Gets a Makeover
  New Workplaces, More Technology, More Options for Study & Research
  By Lucinda Covert-Vail & Tom McNulty ... 15

Social Sciences, Statistics & Mapping
- Running GIS on Open Source
  By Yakov Smotritsky .................. 17

- Recommended Reading for SPSS & SAS Programmers
  By Frank LoPresti ...................... 23

- The 2004 Geospatial Summer Symposium
  By Antonio Lopez ...................... 27

Technology Tips & Training
- How to Download Your NYUHome E-mail
  By Victor Santana III .................. 21

ITS Computer Labs
- Technology in the ITS Multimedia Classroom
  By Robyn Berland, with Robert Whelan .................. 37

Digital Library
- NYU Partners on $5.2 Million in Awards from the Library of Congress
  By David Ackerman ...................... 40
How can a freshman resident at Weinstein Hall who interned for the NAACP in her hometown of Midland, Texas get connected with another freshman resident from Malibu, California who is interested in social justice initiatives and who lives in the same building but on a different floor? NYU’s Department of Residential Education supports extensive social and educational programming, active hall student councils, and community-based living-learning programs. Nonetheless, when limited to face-to-face contact, hall residents do not have many opportunities to keep up with what is going on in their communities, communicate with each other, and initiate connections and shared activities with the whole range of interesting residents, staff, and, in some instances, faculty in their buildings.

Many hall residents have reported the “lack of community” they feel, and their wish that there were better ways for them to have meaningful interactions that would increase the “sense of community” and help them to take advantage of all the opportunities that NYU offers.

**SOLUTION:**
**The Virtual Community Development Tool**

As of September 2004, the two Weinstein residents of our example, as well as the other 11,000-plus NYU residents, have the ability to meet and communicate through one of the country’s most creatively integrated approaches to connecting resident students.

The new Virtual Community Development Tool was designed to address students’ needs for connection and community by adding powerful interactive communications tools to the existing information-and resource-oriented residence hall websites at [http://www.nyu.edu/housing/residencehalls/](http://www.nyu.edu/housing/residencehalls/). This resource combines a set of hall-editable web pages, a Blackboard site for every hall, and E-mail Direct for contacting all residents. Residents can access these powerful interactive communications tools through both the individual hall websites and the Residence Hall Community Connection channel in NYUHome.

The development of the Virtual Community Tool brought together the expertise of the ITS Academic Computing Services and eServices departments, the Department of Housing and its website development staff, and the Department of Residential Education and its community education staff in a unique and wonderful collaboration to enhance students’ experiences in NYU residence halls.

To understand what the Virtual Community Tool offers, envision our two Weinstein students having a means to communicate with the help of interactive Internet software. They can view the latest events in their building, share information about a class, participate in interactive discussion groups focusing on classroom, and more.

![Figure 1. Hall residents can use the hall web and Blackboard sites to keep up with events and connect with other residents throughout the hall.](image-url)
personal, and residence hall topics, and learn about campus resources.

The principal residence hall website and Blackboard tools that have been introduced this semester include:

- **Community Opportunities** pages, with links to all the interactive communications tools and hall resources.
- **Learning Opportunities** pages with access to hall programs, living-learning options, and other learning and support resources available to residents.
- **Community News**, with hall-editable Notices and Features, Community News Reports, Hall Council News, and Coming Events announcements that hall residents, organizations, and staff can contribute to.
- **Staff greetings**, information, and e-mail links for personal communications and assistance.
- **Connect! Community Forum**, using Blackboard to provide hall residents with their own discussion boards on community interests; survey, signup, and voting opportunities; floor and group communication and collaboration tools; and sometimes hall event, Faculty Fellow, staff contact, news, and other special pages.
- **Hall Student Council** pages.

**TOOLS TO HELP HALL STAFF MAINTAIN THEIR WEBSITES**

As part of the Virtual Community Tool, **Contribute**, a software package by Macromedia, gives hall educational staff the ability to easily and safely edit critical content in their hall web pages without knowing HTML or waiting for a website developer to make the changes. The Housing website developer, in collaboration with Residential Education staff, has constructed the hall pages with Macromedia Dreamweaver templates, which protect site navigation and organization while allowing content owners to make changes in designated editable areas of their pages. The developer then used an encrypted **Contribute** Connection Key to give the Community Development Educator (CDE) in each residence hall permission to make appropriate edits in the hall web pages and publish them to the server. Editable areas in the hall Community News pages include staff Notices, as well as student-contributed Features, News reports by residents, Hall Council News by the student Hall Council, and the latest Coming Events by event organizers.

**Contribute** lets hall staff use simple menu tools to edit and format content on their hall web pages; create tables, hyperlinks, and other web elements; and import formatted material already prepared in Microsoft Word by other hall staff or residents. Meanwhile, the permission controls put in place by the developer prevent serious damage to hall web pages, creation or deletion of pages, or access to any other websites. When their edited pages look the way they want, CDEs simply click the Publish button on their **Contribute** screen to instantly upload the revised pages to the server, without the need for a personal website account. These powerful and flexible **Contribute** tools make it easy to keep the hall websites dynamic, interactive, and up to date.

**BLACKBOARD: NOT JUST FOR CLASSES ANYMORE**

Many readers are familiar with Blackboard through its use as an online course management tool at NYU, but the capabilities of this powerful software package are not limited to classes. Some of the most exciting interactive features of the Virtual Community Development Tool have been implemented through Blackboard, which offers a broad array of flexible communications tools while providing security by limiting access only to hall residents.
During the summer of 2004, ITS, Housing, and many Residential Education staff collaborated on developing a template of Blackboard features with great potential for enhancing hall communications. The Residential Education course builder for the Blackboard sites and many hall educational staff members tested the template, contributed ideas, previewed features, and became acquainted with the program before their formal training.

At the end of the summer, ITS cloned the template that had been developed and gave each residential community at NYU its own site. Once that was done, hall staff set about adapting the tool to their own needs. There is no “typical” NYU residential community; some communities such as Hayden and Weinstein halls are close to a traditional campus residence hall, while others such as Water Street and Uptown can be confused with the swanky pads inhabited by young professionals. Some communities are small and cozy, while some stretch across the 80 acres of trees and grass of Stuyvesant Town. The way Blackboard has been used in the halls reflects this diversity. Following are some of the highlights.

**Community Groups**

The role of Resident Assistants (RAs) in community development cannot be overstated. They are the front line resources for residents, and the key community partners that link the institutional and personal elements of residence halls. It is only natural, then, that RA uses of Blackboard have been an area of rapid development of the project.

In some of the residence halls, RAs have requested that a Blackboard group be set up for their residents. Generally, each group has been given its own discussion board, e-mail list, and file distribution facility. RAs can use these groups to e-mail residents, to elicit feedback in discussions, and even to encourage residents to help produce a hall newsletter.

**Calendar**

RAs are constantly trying to help residents connect with each other, and to learn about resources and opportunities for personal growth. There is always something going on in the communities, and it is not uncommon for several activities to be scheduled on the same day. Some of the residence halls have started using the calendar function of Blackboard to post information about programming times and dates.

**Hall Elections**

A number of residence halls have conducted elections for their Hall Councils through Blackboard. The ballots are sent out as a survey, and results are available immediately (even while the election is in progress). In some instances, the candidates have been able to
post blurbs about themselves on the site.

**Faculty Fellows in Residence**

The Faculty Fellows in Residence have been added to the different community sites, and have been actively using them. Some of the faculty have added their own profiles to the sites in an effort to introduce themselves to residents they have not met in person. Faculty have also used the sites to advertise programs and distribute materials for informal discussions. An unexpected benefit of the integration of faculty in residence into the Blackboard communities has been that they have contributed their expertise to the sites, redesigning graphical elements and adding functionality to them.

**Wellness and the University**

In light of the University’s attempt to raise consciousness of wellness resources on campus, all building sites offer a resources area listing useful wellness links. Hall staff and residents are able to refer to the resources area for immediate access to a collection of University links tailored to the specific needs of residents. The links themselves are the result of staff input during the development stage. A few weeks into the Fall 2004 semester, a direct link to the University’s new Wellness Exchange home page was prominently added to all hall sites.

**E-MAIL DIRECT**

Even with all of the new website and Blackboard communication capabilities available through the Virtual Community Development Tool, residents sometimes need a little nudge to check things out. When residents are bouncing between classes, extra-curricular activities, and friends, and at the same time getting to know the city, simply informing them of important hall and University events can be a daunting challenge, but NYU E-mail Direct provides a way.

NYU E-mail Direct is a bulk e-mail service through which pre-authorized NYU faculty, staff, and administrators can request to send an e-mail message to a segment of the University community or to the entire community (http://www.nyu.edu/its/emaildirect/). This handy tool allows residence hall educational staff to selectively grab the attention of any sector of residents living in any of the NYU residence halls.

**PROGRESS OF THE VIRTUAL COMMUNITY DEVELOPMENT PROJECT**

Although access, staff training, and marketing of some features of the new Virtual Community Development Tool are still being rolled out, examination of the hall websites and Blackboard sites shows that many hall communities are already effectively using a variety of the new interactive tools to expand hall communications, increase resident participation in community activities and programs, facilitate access to resources and support, and build vibrant hall communities.

*Maurice Washington is the Director of Community Development in the Department of Residential Education; Lance Morrow is the Director for Strategic Planning in the Department of Housing, and website developer and webmaster for Housing and the Division of Auxiliary Services; Alexandre de Miranda is the Community Development Assistant in the Department of Residential Education, and a student in NYU's School of Law.*
The Media Matrix
Improving Arts Education at SCPS

By Lucy Appert, Ethan Ehrenberg, Gloria Rohmann & Robert Squillace
lucy.appert@nyu.edu; ethan.ehrenberg@nyu.edu; gloria.rohmann@nyu.edu; robert.squillace@nyu.edu

SCPS' new Media Matrix is a vital networking tool that links instructors and students to the wide range of resources available in Bobst Library, on the Web, and among our own faculty. Like many stories, that of the Media Matrix project began with a problem and a piece of luck. This robust online tool originated in the General Studies Program (GSP), a two-year, full-time day program in NYU's School of Continuing and Professional Studies (SCPS).

GSP students are freshmen and sophomores who, after completing the school's liberal arts curriculum, earn associate's degrees and transfer into one of NYU's seven other undergraduate colleges to complete their bachelor's degrees. The program requires all freshmen to take the two-course Cultural Foundations sequence, which offers an interdisciplinary introduction to the worlds of literature, art, and music. In the 2004-2005 academic year, the Cultural Foundations sequence has more than 20 instructors teaching approximately 850 students.

While each instructor chooses the literature he or she covers, a Program Committee has traditionally selected an art and music book to be used in common by all sections of the course. Agreement upon which book to adopt was always difficult to come by; indeed, in just the past five years, three art and two music texts were used. The last of these, a combined art/music text, proved the least adequate of the lot. So, in fall 2003, Dr. Heather Masri, Co-Director of Curriculum Development, constituted a Curriculum Committee to look into the options for dealing with this persistent issue. To explore technical approaches to the problem, SCPS instructors Dr. Lucy Appert and Dr. Robert Squillace were appointed as the Technology Sub-Committee.

When the Curriculum Committee began to meet, it soon became clear that the best art texts on the market specialized purely in the study of art, while the only music texts worthy of consideration failed to address the precise needs of GSP's musically inexperienced students and cost far too much. The problem seemed insoluble: a combined art/music text tended to short-shrift both art and music, but requiring a pricey text for each discipline was pedagogically and financially indefensible. Then, luck intervened.

Perhaps the most exciting aspect of this project is its potential as a tool in the investigation of interdisciplinary relationships.

The Birth of the Matrix
Drs. Appert and Squillace had been pursuing the idea of linking instructors to resources already publicly available on the Web, but soon concluded that the tendency of websites—even educational sites—to flicker in and out of existence made large scale reliance on such sources inadvisable. When they concluded that any web-delivered resources would have to be developed by GSP and located on an NYU server, Dr. Masri suggested that they speak with Ethan Ehrenberg, an Instructional Technology Specialist at the ITS Faculty Technology Center, about possible ways to use the Blackboard learning management system for this purpose.

At his initial meeting with Appert, Ehrenberg recollected that Gloria Rohmann, Head of Bobst Library’s Avery Fisher Media
Center, had previously worked with NYU’s Music Librarian and Adjunct Instructor of Music, Kent Underwood, to create a course-specific site featuring web-delivered music from the Library’s holdings. Squillace had participated in the pilot for the Library’s E-Reserve system the previous spring and knew something of its potential; hearing Ehrenberg’s description of Rohmann and Underwood’s project raised for him and Appert the intriguing possibility of dispensing with a music text altogether.

When the authors of this article met in December 2003, the framework for the Media Matrix rapidly took shape. Perhaps the need for a music text could be obviated by delivering a set of links, via Blackboard, to streaming music files in the E-Reserve system, and by accompanying these files with whatever sort of textual analysis was necessary.

Indeed, we could even insert links to entries in the Grove Music Online, a encyclopedic account of the history of music and musicians, accessible through the Library’s links to online databases. Through an innovative use of Blackboard, the Media Matrix would create a shared content repository, or mini content management system, so that faculty could access and incorporate common material in their individual Blackboard course sites.¹

DEVELOPMENT & IMPLEMENTATION

While its underlying concept sprang to life quickly, the Matrix site still had considerable growing pains to endure before it would be ready for use. In spring 2004, Appert and Squillace tested the practicality of the basic concept in a pilot project. First, they selected musical compositions from the Avery Fisher collection, then Rohmann encoded them for streaming audio. Links to the streaming files, which reside in the Library’s archives, were then posted with Ehrenberg’s help on the Blackboard pages for Squillace and Appert’s courses. The pilot proved an unmitigated success, with Appert, Squillace, Ehrenberg, and Rohmann, as well as Drs. Nancy Reale and Brian Culver of the Music Sub-Committee, all agreeing that the Matrix was superior to any available textbook.

Since that time, this article’s four authors have concentrated on the technical aspects of developing the project for full-scale implementation, while Reale and Culver have focused on producing the textual analyses of music to be used by instructors. But a limited pilot project differs significantly from a full-scale teaching site for a course sequence with 35 sections each semester.

Our first challenge in developing the production model of the Matrix involved basic site organization—how could we best confine access to the site so that the music posted on it would conform to the rules of the E-Reserve system, and at the same time give individual instructors the maximum flexibility in tailoring the material to their own courses? We quickly realized that making the Matrix site directly available to students would not work; no two instructors teach the same music in the same way, so the material we posted needed to pass through the mind.

¹ We have since learned that Blackboard, Inc. released a fully featured content management system as part of the Academic Suite. ITS is currently testing this system and we look forward to using the expanded functionality of that system with the Media Matrix content.
of the instructor before it entered the ear of the student. We determined that the best solution was to limit access to the Matrix site to instructors; they could each then decide what to link to in their own individual Blackboard course sites.

Our solution created a fresh obstacle, however: since instructors would need to be able to copy folders from the Matrix site, how could we guard against the inadvertent deletion of our painstakingly assembled amalgams of links by less technically proficient faculty members? We realized that the best insurance was redundancy; not only did we build a great deal of repetition into the Matrix site (e.g., the same links to Medieval compositions might appear under both “Music Units” and “Build Your Own Music Module”), but we also created a duplicate of the entire site in a “Master Matrix” shell accessible only to the project team.

Further, we created a two-tiered system of musical coverage, compiling individual modules for every relevant genre (plainchant, organum, oratorio, and so forth) that contain a small number of musical examples and a great deal of textual support, as well as more extensive lists of related works for instructors to teach, should they wish. These examples greatly exceed the scope of any provided by the CDs that accompany music texts now on the market.

In order to complete folders for the classes we offer on the music of the Middle Ages in time for the Fall 2004 semester, we divided our labors to make the best use of our time. Appert took charge of the general site organization, determining the basic divisions of its content areas and the site’s appearance, while also creating, in consultation with Ehrenberg and Rohmann, the site’s non-musical areas. These areas offer toolboxes designed to maximize the site’s potential in the hands of each instructor, and allow for the creation of groups of images to supplement the art text. Appert, with collaborative and editorial assistance from Squillace, also compiled an illustrated training manual for first-time users.

Squillace, meanwhile, took responsibility for developing the musical folders themselves, choosing the genres to be represented for each period and the individual compositions to be included, in consultation with Reale and Culver. He then arranged with Rohmann the encoding of CD tracks into streaming files and the posting of links to these files, in addition to integrating the substantial content generated by Culver and Reale into this new teaching system. Reale wrote a series of pieces on the basic elements of music, while Culver contributed listening charts for individual compositions. They also created brief introductions to the music of each period covered by the modules, to which Squillace and Appert added multimedia links.

The Media Matrix site has made such rapid progress primarily because we have not only included people with technological and humanities expertise in its creation, but we have also made it the specific responsibility of some Committee members to act as liaisons between the two worlds.

**THE MEDIA MATRIX IN ACTION**

The Media Matrix now delivers all of the necessary components for our basic fall 2004 music curriculum, which covers the Middle Ages and early Renaissance; in spring 2005, the site will include the Baroque, Classical, and Romantic periods. With the original listening files from Underwood’s course and links to Grove Music Online as its basis, we have expanded
the list of streaming files and added original teaching materials. These include listening charts, time-keyed guides through individual music selections; a teaching module on the basic Elements of Music; and supplemental materials such as images of medieval manuscripts and instruments. We have organized the material into chronological teaching modules covering the major musical periods from our courses.

Instructors now download modules from the Media Matrix to their own Blackboard sites and selectively assign material from them in their syllabi, in effect creating their own textbooks. Students access the material by logging onto Blackboard, printing out or downloading the assigned texts, and using them to guide their listening to the assigned music selections. Students can then bring the texts to class, where instructors will incorporate the material, including listening selections, into their teaching. Access to all copyrighted materials is strictly limited to instructors and students currently enrolled in the courses.

While the modules in themselves provide a complete curriculum, instructors can also customize them by adding or eliminating material, or they can create their own modules organized by composer, genre, form, or other category. To facilitate this practice, we have provided an extended list of alternate listening files and links to online textual resources such as Indiana University’s online library of complete opera libretti and the online image collections from New York-area museums. Instructors are also encouraged to require their students to buy complete versions of longer works, such as symphonies or operas, through links to iTunes or other online music retailers, such as Amazon.

We are aware that for some instructors and students, the technical aspects of an online curriculum may seem daunting. To make the experience as easy and pleasant as possible, we have created faculty and student toolbox features that include system requirements, links to all of the necessary software downloads, and links to key library resources. The instructor’s manual, available both in print and on the Matrix site, also walks instructors through the major functions of the site.

The Matrix project offers many advantages over conventional
textbooks. For students, it has the potential to solve some of the issues associated with learning about music in a survey course. Files from the Elements module that explain basic music concepts (such as polyphony or rhythm) can be included within the chronological modules, where students must apply their knowledge of the basic concepts to more complicated works. For instructors, the Matrix site offers permanent discussion board forums that give our department a virtual file cabinet for sharing ideas and materials. Instructors and students benefit from becoming more familiar with the library’s electronic media resources and gaining proficiency in navigating them.

Perhaps the most exciting aspect of this project is its potential as a tool in the investigation of interdisciplinary relationships. Music textbooks generally include a few titillating pages devoted to key artistic or literary trends that connect with specific musical periods. The Matrix modules enable instructors to pursue those connections more rigorously. Listening files can be presented alongside image and text files to aid students in making the kinds of connections our courses require.

All of these advantages stem from the fact that the Media Matrix exploits the flexibility of electronic media to recombine the same materials into a variety of different, but equally coherent, learning strands. For example, teaching a unit on women composers using a traditional music textbook would mean assembling a hodgepodge of reading and listening assignments, probably spread throughout the textbook—or several different ones—and supplemented with lots of handouts and listening tracks from the instructor’s private music library. The Matrix simplifies the assembly of such a unit and allows instructors to create a sustained narrative that promotes comparison both within the unit itself and with other units. This flexibility reflects the reality of our department, where specialists in different areas (literature, art, music) approach the subject matter differently and tailor it to fit their teaching styles.

**TRAINING AND SUPPORT**

We understand that the success and positive reception of the Media Matrix will depend to a great degree on the faculty’s ability to use this resource and to incorporate it in an easy and intuitive way into their current work process. We therefore decided to launch the project with the first of perhaps many hands-on training sessions in June 2004 and early in the Fall 2004 semester, and we hope to supplement them with occasional faculty brown-bag seminars on Blackboard and Library resources.

After an initial roll-out phase over the coming academic year, we plan to evaluate the site’s progress with a survey of the faculty who have used it. We look forward to reporting next year on the project’s reception and, we hope, growth. For more information about the Media Matrix, send e-mail to Robert Squillace (rs84@nyu.edu), Lucy Appert (lga2@nyu.edu), Ethan Ehrenberg (ethan.ehrenberg@nyu.edu), or Gloria Rohmann (gloria.rohmann@nyu.edu).

For more information about Blackboard, see “What’s New with NYU Blackboard” on p. 14.

Lucy Appert is an adjunct assistant professor in the SCPS General Studies Program; Ethan Ehrenberg is an Instructional Technology Specialist and Blackboard Support Specialist at the ITS Faculty Technology Center; Gloria Rohmann, an early user of streaming media at NYU, is Head of Electronic and Media Services at NYU Libraries; Robert Squillace has taught Cultural Foundations in the SCPS General Studies Program since 1998.
Have you seen the commercials on television advertising a “self-defending network?” University computer networks across the country are undergoing a transformation to become “self-defending”, and NYU-NET is no exception. Over the years, our network has become faster, more reliable, and increasingly vital to a growing number of University business, communication, and research functions. In addition, the network is being made progressively more secure, in response to the increasingly frequent attacks occurring over the Internet, and with the help of the expanding palette of tools that NYU’s Information Technology Services (ITS) has at its disposal.

A prime example of improved network security at the University is NYU SafetyNET, a new service that was developed over the summer and launched in August 2004 on the entire NYU Residential Network (ResNet). NYU SafetyNET automatically identifies computers on ResNet that are vulnerable to one or more viruses or worms, and acts to protect them and other computers sharing the network from attack. The service then provides the computers’ owners with the tools and information they need to make their computers more secure, and, in cases where the computer is already infected with something malicious, acts to stop the infection from spreading.

This is what is meant by “self-defending”: a network that can detect, isolate, and help resolve many of its own issues without staff intervention. The features of NYU SafetyNET are described below, along with an overview of how the service works, some measures of its effectiveness, and our plans for its future.

BACKGROUND

University student networks in the mid 1990’s were a technical novelty available in limited areas, used mostly by “computer enthusiasts”. Today, almost ten years later, access to the Internet is a requirement of modern academic and social life. The rapid growth in the size of these networks and in the students’ need to be connected has often outpaced technical and educational security efforts. In August 2003, just prior to the start of the academic year, a situation arose that brought all of this to a head: the Blaster and Welchia worms appeared on the Internet.

These worms attacked a flaw discovered in almost every version of Microsoft’s Windows operating system, and infected any computer that was not properly patched. Many computers were infected, especially in large university networks, where, in contrast to corporate networks, there is typically little central control over individual computers. The impact these worms had on large networks across the Internet was a wake-up call that something more had to be done to protect both individual computers and the networks themselves.

Universities across the country, NYU included, were swift in responding to these attacks, and a common technical strategy began to emerge from various individual efforts. In particular, some universities started to check computers for security problems automatically when they were first connected to the network, and to take immediate preventative action if a problem was found. NYU already had a residential network registration system in place (via the ITS Start page) that would lend itself to these additional countermeasures. Once it was clear that this strategy was an effective
method of securing individual computers to combat the spread of these attacks, ITS started work on NYU SafetyNET, designing it to be fast and scalable to our large network.

**PHASE I THE PATCH NETWORK**

When an unknown computer first attempts to connect to NYU ResNet, it is automatically placed into a special pre-registration network. When students open their web browsers, instead of connecting to their normal home page they are connected to the ITS Start page, where they are walked through the ResNet registration process. Until they successfully complete the registration steps outlined on this page, students are unable to visit any other sites on the Internet, and no one else is able to communicate with their computer.

This ResNet registration process has been in place since 1997, and is familiar to returning students living in residence halls. The Start page asks them to enter their NYU NetID and password, then verifies that they have plugged their computer into the correct jack in the room to which they have been assigned. It is at this stage that the new SafetyNET process begins.

Once the Start page verifies who the student is and where they live, SafetyNET initiates a vulnerability assessment, or “scan”, of the student's computer. SafetyNET uses an open source security scanner that allows ITS to check for many different potential problems. SafetyNET currently checks for common vulnerabilities found in Windows computers, specifically the vulnerabilities attacked by the Blaster, Welchia, and Sasser worms. It is also capable of checking for thousands of other computer security problems, including flaws in Macintosh and Linux computers. Further, because its code is open source, the SafetyNET scanner enables NYU to contribute to the development of additional security tests that can be used by other universities (see p. 20 in this issue for an explanation of open source software).

If no security vulnerability is detected, the student's computer is connected to the public NYU network, NYU-NET, where he or she can then use the Internet normally. If one or more security vulnerabilities are detected, the student is informed of the problem, then automatically moved into the SafetyNET “patch network”. The patch network is a private network designed to isolate vulnerable computers where they are protected from attack, while at the same time connecting them to the resources students need to make their computers more secure.

In the patch network, each computer’s web browser is redirected to a custom support website that outlines a series of steps the student must take to disinfect and protect his or her computer. SafetyNET’s “self-service” design gives people the information they need to take action themselves, while offering the option of calling on ITS support staff should they need additional individual help. Perhaps more important, it educates people about the best practices for the security of their computers—including keeping up to date with the latest patches, using their computer’s built-in automatic update mechanism, and running current anti-virus software.

Once students whose computers have been placed in the patch network take all of the corrective steps outlined on the patch network website, they are instructed to initiate another security scan of their computer. If they pass this test, they are automatically connected to NYU-NET, where they can use the Internet normally. If they fail the test, they are informed of the specific issues that remain and are sent back to the first page of the patch network website for an opportunity to rectify the remaining vulnerabilities. They are also given instructions on how to contact the ITS Client Services Center, which can provide help over the phone or refer the problem to ResNet support staff for hands-on assistance.

**FINDINGS AND ISSUES**

In fall 2004, more than 10% of the students who attempted to connect to ResNet were detected by SafetyNET as having brought computers with serious security vulnerabilities to campus. As of mid-October, some 9,800 students had registered for ResNet, most of them in an initial rush of 9,500 registrations occurring before the first day of classes. Of that number, approximately 1,000 students had Windows computers that failed the initial SafetyNET security check and were placed into the SafetyNET patch network. Of those 1,000 students, about 800 (or 80%) were able to secure their
own computers by following the instructions on the patch network website, and were connected to the Internet automatically. About 200 (or 20%) needed assistance with the process and contacted the ITS Client Services Center to request help. Approximately 75 of these students were referred to ResNet staff for hands-on assistance.

Students whose computers were already infected with viruses or, increasingly more common, “infested” with spyware had the most difficulty using SafetyNET. Their computers failed the initial security test and were placed into the SafetyNET patch network. However, once inside that network they were unable to install the patches they needed in order to pass the final security test and get connected to the Internet. This happened to approximately 50 students, which is about one-half of 1% of all students with computers on ResNet. Computer support personnel across NYU and across the Internet are reporting an increasing variety of problems associated with spyware, and the damaging side-effects it can have on unprotected Windows computers.

The SafetyNET security tests proved to be about 99% accurate in identifying computers with problems. Thus, some computers did slip through the cracks, which was expected in our first deployment, given the size of the network involved. Throughout the month of October, on any given day, SafetyNET scans detected that there were approximately 40 vulnerable computers on NYU ResNet, yielding a vulnerability rate of less than one-half of 1%. Given that the vulnerability rate in incoming computers was 10%, we were pleased that the first phase of SafetyNET had resulted in a decrease of more than one order of magnitude, but we knew that there was still more work to be done.

**Phase II**

**The Quarantine Network**

Our first phase of NYU SafetyNET was proactive—it was designed to find vulnerabilities on computers as they entered the network and encourage their owners to fix the issues before they became a serious problem. Unfortunately, there are and will continue to be security problems caused by other issues, most significantly computers infected by means outside of SafetyNET’s control—whether it be from a home network, from the download of a file containing a Trojan virus, or from a website with malicious content. Further, in a network of ResNet’s size, a system that is 99% effective will miss a few dozen computers with serious vulnerabilities.

This is where the second phase of SafetyNET, the “quarantine network”, comes in. The quarantine network is a separate network that offers reactive security, or the effective handling of a security incident after it occurs. ITS has several methods of detecting a computer that is already in the network and has been infected with a virus or worm, or compromised by a hacker. Upon detecting such a computer, we first attempt to get in touch with the computer’s owner to inform him or her of the threat to the computer and provide instructions on how to disinfect it.

However, in a world where many students come to campus with a cell phone and more than one e-mail address, it is becoming more and more difficult to reach them. After a given amount of time, if ITS determines that no action has been taken by a student, we then move the student’s computer into the SafetyNET quarantine network. While in this network, a computer’s web browser is automatically redirected to a special support website, and all other Internet access is blocked. This step is taken in order to protect other computers on the network from becoming infected, and to have a direct means of communicating with the student. Once students get in touch with ITS Client Services and resolve their computers’ security problem, their computers are moved back into NYU-NET, where they can freely connect to the Internet again.

**Conclusion**

NYU SafetyNET has been effective in greatly reducing the number of student computers that are vulnerable to common attacks. By encouraging people to use up-to-date anti-virus software, proactively patch their computers, and use Windows’ built-in ability to keep itself updated, we hope to decrease the impact of future attacks. Computer researchers continue to find flaws in every type of computer, and hackers continue to exploit them to their own gain. But basic computer security education and routine preventive measures have proven themselves to be effective means of combating these attacks.

The “self-defending” network advertised on television is based in large part upon the ability of large networks to automatically detect and respond to security problems. NYU’s SafetyNET is a key step in our ability to automate the task of basic security detection and response, and ITS will continue to find ways to speed our response to technical security problems and provide an increasingly secure
network. Ultimately, though, the best way to protect a network of this size is through education and awareness. Computers are excellent at automating routine tasks and performing them quickly, so once people learn how to set up the basic security features, their computers will take care of most of the work for them. For more information on how you can help secure your own computer, please visit the ITS Security Group’s website at: http://www.nyu.edu/its/security/ and be sure to follow the Top Ten Security Guidelines at: http://www.nyu.edu/its/security/guidelines.html.

Phil Rodrigues is an ITS Senior Network Security Analyst responsible for the technical strategy behind securing NYU’s network. He also serves in the US Army Reserves with the Information Operations Command, and is a visiting scientist at Carnegie Mellon’s Software Engineering Institute.

What’s New with NYU Blackboard?
By Ethan Ehrenberg

The ITS Faculty Technology Center (FTC) has a number of new training and support options to help faculty using NYU Blackboard, the University’s online course management system.

ONLINE TOOLS
• Intro Tour
  Never used NYU Blackboard? Find out what it is, what it can do, and why it is used in over two-thirds of NYU's courses.

• Getting Started Assistant
  Need help getting started? This Assistant guides new or returning faculty through the process of setting up and accessing a Blackboard course.

• Self-Paced Tutorial
  Ready for advanced features? This tutorial will take you from beginner to intermediate status in less than two hours.

Access these features and more on the ITS FTC Blackboard website: http://www.nyu.edu/its/ftc/blackboard/.

• Blackboard Help Request Form
  Issues with accessing or activating a course? Problems with student enrollment? Questions about how to use Blackboard? Experiencing system problems or an error? The new Blackboard Help Request Form is the fastest way to have the ITS team of Blackboard experts solve whatever obstacle you may encounter.

Access the Blackboard Help Request form through NYUHome at the top of the Blackboard Classes Channel, or at http://www.nyu.edu/its/ftc/blackboard/problem.html.

FACE-TO-FACE ASSISTANCE
• Hands-on Workshops
  Workshop participants enjoy expert assistance in building engaging Blackboard course sites that can transform teaching and learning.

• Blackboard Faculty Clinic
  The Doctor is IN! Each Friday from 11:00am – 1:00pm at the Faculty Technology Center, 35 W. 4th St., 2nd Floor. Faculty already using Blackboard can walk in to share questions, troubleshoot problems, and brainstorm ideas with other faculty members and the resident Blackboard Doctor on call.

To access a schedule of workshops, request a new workshop, and find more information about the Clinic, visit the ITS Blackboard Classes page: http://www.nyu.edu/its/classes/blackboard.html.

Fall’s Helpful Hint:
Course shells must be activated each semester using the course request form (see http://www.nyu.edu/its/accounts/facaccts.html). Once activated, a course shell should be accessible online within 15 minutes. The roster, however, may take up to 8 hours to populate, and content carried over from a previous semester may take up to 24 hours to appear.

Remember to make your course available and then click “Update Channel Information” at the bottom of the Blackboard Classes channel if you don’t see your class listed.
Fall/Winter 2004 • Connect: Information Technology at NYU

Bobst Library Gets a Makeover
New Workspaces, More Technology, More Options for Study & Research

By Lucinda Covert-Vail & Tom McNulty
lcv2@nyu.edu; tom.mcnulty@nyu.edu

Since Bobst Library opened, just over thirty years ago, tremendous changes have occurred in the worlds of scholarly communication and higher education, and, consequently, in the way people use libraries. In the 1970s, few library users sought rooms in which they might study or conduct research in groups. Rather, most wanted quiet areas in which to read or study independently. Today, many students and faculty members from diverse fields work collaboratively, while others seek quiet reading rooms, and still others need areas in which to work with a laptop while using print and digital library materials.

This year, generous gifts from Mamdouha S. Bobst and Kevin Brine enabled Bobst Library to undertake an ambitious renovation program that includes the creation of a variety of spaces for learning and research on the Lower Levels, 1st floor, and Mezzanine. The overarching goal of Phase I was to create a 21st century learning environment with spaces that:

- reflect a variety of learning styles, including individual study, collaborative learning, and the peer-to-peer environment embraced by today’s student;
- allow librarians to work with students in a variety of ways—from individual or group consultation to formal classroom instruction;
- accommodate established and emerging technologies for teaching, learning, and research.

The Planning Process
Recognizing the fact that a truly user-centered facility could only be achieved with significant input from the people who use the Library, we employed a variety of information-gathering techniques throughout the planning phase that preceded Phase I. Information was gathered by surveying, observing, and engaging library users directly in the planning process.

An online survey completed by hundreds of students and faculty members elicited their opinions and ideas on diverse topics, including “library as place”, the visual environment, privacy and security issues, lighting, acoustics, furnishings, and equipment, among others.

We observed visitors’ working styles and preferences by touring the entire Library three times daily for one week. On these information-gathering tours, we noted where people worked; how they were using the Library, its collections and computers; and whether

Renovations include improved study areas in Lower Level 2.
they worked independently or in groups. Direct observation provided data on the real working methods of our diverse population—information that proved indispensable in designing spaces appropriate for the contemporary scholar. Mechanisms designed to elicit additional input from students and faculty included meetings with student groups, student senators, the FAS Graduate Student Council, and the Bobst Renovation Advisory Committee, composed of librarians and representative students and faculty members from across the University.

**WHAT WE LEARNED**

The information gathered during the renovation planning process pointed out some of the significant transformations that have occurred in the way students and faculty members work, but it also highlighted those aspects of the Library that seem to have remained constant. The contemporary student consults with peers, faculty members, and librarians one-on-one and in small groups. They also multitask, using traditional print collections in tandem with online resources, laptops, and even cell phones.

What does *not* seem to have changed since Bobst opened in 1973 is the need for a physical library that:

- offers attractive, effective study spaces;
- provides print, audio, video, and electronic collections that support the curriculum, learning, and research;
- is staffed by skilled professionals who understand the scholarly communication processes, from the basic undergraduate level to the Ph.D. student to the research faculty member.

**THE RESULT**

From the very first day of the new academic year, Bobst’s renovated spaces appear to be attracting more students to the Library than ever before. And because we expect group study spaces to be among the most popular facilities, we’ve now instituted an online reservation form: [http://roomreserve.library.nyu.edu](http://roomreserve.library.nyu.edu).

Phase I of the renovation should be completed by the beginning of the Spring 2005 semester. The planning process for Phase II, the extension of renovation to the upper floors of Bobst, will begin later that semester. As in Phase I, the Library will continue to work closely with our users to realize a library that meets their need for print and digital collections along with new technologies, diverse reading and consultation spaces, and a quality environment that facilitates learning and discovery.

---

**Lucinda Covert-Vail is Director of Public Services at NYU’s Bobst Library; Tom McNulty is Librarian for Fine Arts at NYU’s Bobst Library.**

---

**Enhanced Library Facilities**

The Brine Library Commons, on Lower Levels 1 & 2 (formerly, the A- and B-Levels), includes the following spaces and technologies:

- Wireless access—bring your own laptop, or borrow one of ours to access the Internet
- Snack bar area with vending machines and café tables
- A variety of reading rooms, some equipped with research and e-mail stations and one designated for “quiet” work
- Group and Individual study rooms
- Three computer classrooms
- Adaptive technology rooms with computers equipped with specialized software for people with disabilities
- Leisure reading lounge

The Humanities and Social Sciences Reference Center (1st Floor) includes:

- A newly configured reference desk that is immediately visible as people enter the building
- 41 public workstations, with network printing
- Consultation rooms where students, faculty members, and other researchers can meet with librarians individually and in small groups
- New, easier-to-find offices for subject specialist librarians in the Humanities and Social Sciences
Over the last 10 years, GIS (Geographical Information Systems) has become an essential part of a wide range of computerized applications in a variety of fields, including environmental protection, urban and regional planning, business planning, transportation, demographic analysis, military operations, and optimal location planning.

The software market has responded to the increased demand for mapping and geospatial solutions with a diversified set of proprietary GIS packages, such as Arc/Info, ArcView, and ArcIMS (Environmental Systems Research Institute, Inc. [ESRI]); MapInfo (MapInfo Corp.); GeoMedia (Intergraph); IDRISI (Clark Labs); Autodesk GIS (Autodesk); and many others. Simultaneously, the open source community has been actively developing products to meet practically all the basic needs of GIS users. Moreover, GIS users and developers now have the luxury of choosing from a variety of open source components to build viable applications of their own.

**GRASS**

The centerpiece of this type of open source development is a robust GIS package. It is widely recognized in the open source GIS community that GRASS (Geographical Resources Analysis Support System) is the largest, most powerful, and most reliable Free Software GIS project. GRASS is a raster/vector GIS and contains over 350 programs and tools that can create, manipulate, and store spatial data.

GRASS is well-documented and provides the opportunity for a person with basic C language programming skills to write and link his/her own modules to the package's internal “front end”. The general structure of these modules permits their use in either an interactive or command line version. The ability to study the code organization of existing modules is very helpful and facilitates the creation of new modules.

As with many ongoing projects, the number of options, flags, and parameters has grown quickly, and it has become inconvenient to remain in the command line environment (which was the only GRASS option 10 years ago). The development of an interactive front end was therefore a very useful option. The graphical user interface (GUI) for GRASS is “tcltkgrass” and is based on Tcl/Tk scripting language libraries. Working with GRASS here in the ITS Social Science, Statistics & Mapping Group, we were able—without significant expertise in Tcl/Tk—to expand the main tcltkgrass menu to include our own subset of modules with specific interactive windows.

**POSTGRESQL/POSTGIS**

GRASS has a limited internal database that is capable of supporting only a single attribute for each vector object or raster cell category. For projects with more complex data structures, the team of GRASS 5.7 developers has overcome this internal limitation by connecting GRASS to an external database management system such as PostgreSQL (released under the BSD license by The PostgreSQL Global Development Group). This approach parallels ESRI’s move to connect their own data structures with more powerful proprietary databases such as Oracle.

In general, connecting GIS to a relational database requires an additional software layer. For ESRI products like ArcInfo, ArcView, and ArcIMS, the functionality for such a gateway is provided by an
ArcSDE server. ArcSDE is known to work with a variety of different proprietary databases, including Oracle, Informix, IBM DB2, Sybase, and Microsoft SQL Server. In the case of a GRASS to PostgreSQL connection, the “spatially enabled” functionality is provided by the PostGIS package developed by Refractions Research Inc. (PostGIS is released under the GNU General Public License.)

PostGIS allows advanced topological constructs (coverages, surfaces, networks) to be stored, retrieved, and edited in the PostgreSQL object-relational database system. PostGIS works with purely geometric objects, as well. The names of these objects are: point, line, polygon, multipoint, multiline, multipolygon, and geometrycollections. Our experimentation with PostGIS 0.8.1 under PostgreSQL 7.4.2 in the Red Hat Linux environment was successful, though some announced PostGIS capabilities are still under development. (Note to advanced users: PostGIS 0.8.2 Release has an “Optional Experimental Lightweight Geometry (LWGEOM)” feature that includes four-dimensional geometry.)

GIS ON THE WEB: MAPSERVER

Once a person has developed a GIS application, the next logical step is to make it Internet-available or, even better, web-interactive. A set of proprietary products can help achieve this goal, but it is also possible to do it using strictly open source tools. The number of websites that have accomplished this goal is growing rapidly and most are running on Linux/Apache platforms. Most systems (as Red Hat distribution) already have an Apache server preinstalled. If not, the Apache installation is quite straightforward.

Based on our experience in the ITS Social Science, Statistics & Mapping Group using MapServer, however, the rest of the work required to get an application

Figure 1. This GRASS GIS session displays different raster and vector layers from the Spearfish Database. The Tcl/Tk GUI is used simultaneously with the command line interface.
online can be a bit more complicated. MapServer is an open source development environment for building spatially enabled Internet applications. It was originally developed by the University of Minnesota (UMN) in cooperation with the TerraSIP project, a NASA-sponsored cooperative effort of UMN and a consortium of land management interests.

Before compiling and installing MapServer, we installed a few supporting packages:

- gd: A graphics library for fast image creation.
- FreeType: A TrueType font engine available from the FreeType Project.
- libTIFF: For TIFF/GeoTIFF support.
- Proj.4: A cartographic projection library from the US Geological Survey (USGS).
- libJPEG: From the International JPEG Group.

The MapServer site, http://mapserver.gis.umn.edu/, offers an abundance of information regarding installation, usage, and programming in a MapServer environment. Our particular interest was directed at the PHP/Mapscript module, which provides scripting access to the MapServer C API using a simple yet powerful PHP language. PHP can be configured on Red Hat Linux as a “Server API” in two ways: as an Apache module, or as a CGI. Due to some complicated PHP/Mapscript inner coding problems, this module will not work if PHP is configured as an Apache module… a piece of knowledge which cost us several days of work to learn.

NEW DEVELOPMENTS IN OPEN SOURCE GIS: THUBAN, QGIS, AND GRASS SERVER

Two recently developed open source tools that can serve as geographic data viewers for GRASS GIS may prove to be helpful. The first is Thuban—an interactive geographic data viewer (Intevation GmbH, GNU General Public Licence). Binding the GDAL library, Thuban will support the GRASS raster file format.

The second development is QGIS. It offers support for common vector and raster formats and already has GRASS GIS among its plug-ins. The process of making QGIS work with GRASS is straightforward. Before starting QGIS, you must export two GRASS shell local environment variables, GISBASE and LD_LIBRARY_PATH. GISBASE provides the full path to the directory where GRASS is installed and LD_LIBRARY_PATH is the path to the GRASS libraries. QGIS is actually based on Qt, a multi-platform C++ GUI toolkit. QGIS works with PostgreSQL DBMS once GEOS library has been installed. Fortunately, installing
GEOS (Geometry Engine—Open Source) is not complicated. (QGIS is released under the GNU General Public License.)

And finally, in recent news, the “FLOSS/GRASS Users Conference” was held in Bangkok, Thailand on September 12–14, 2004. (FLOSS stands for Free/Libre Open Source Software). At this conference, Radim Blazek and Luca Nardelli (both from ITC, Trento, Italy) described their current efforts to build a GRASS server on top of GRASS as a client-server system. The challenge they are facing is very serious because the original GRASS design was oriented for stand-alone modules and is not thread safe. If they succeed in their goal, the use of GRASS on the Web will be greatly simplified.


---

**What is Open Source Software?**

The term open source refers to any freely-distributed software whose source code is intentionally made available for people to examine and modify. Popular examples include Linux and Mozilla.

The Open Source Initiative (OSI) is a “non-profit corporation dedicated to managing and promoting the Open Source Definition for the good of the community.” As described on their website, “The basic idea behind open source is very simple: When programmers can read, redistribute, and modify the source code for a piece of software, the software evolves. People improve it, people adapt it, people fix bugs. And this can happen at a speed that, if one is used to the slow pace of conventional software development, seems astonishing.”

For more information about open source, please visit [http://opensource.org/](http://opensource.org/).
Say you have old messages that you would like to keep, but your NYUHome e-mail account is nearing its quota. Or perhaps you simply want to store some messages on your computer or an external disk where you can refer to them even when your Internet connection is not active. These are two of the reasons that people find it useful to download copies of their NYUHome e-mail to their computer.

Although most people access their NYU e-mail through the NYUHome web portal, when it comes to downloading your e-mail, it is probably fastest and easiest to use an e-mail client that runs on your local computer with IMAP or POP capabilities. E-mail clients such as Eudora, Outlook Express, Netscape Messenger, and PC-Pine have both POP and IMAP capabilities. IMAP (Internet Message Access Protocol) and POP (Post Office Protocol) are e-mail protocols which allow you to access your e-mail from NYU’s central server and either download it to your local computer or leave it on the server where it can be accessed from any Internet-connected computer.

Please note that NYU recommends IMAP rather than POP if you use an e-mail client on your local computer to manage your e-mail. However, for the purpose of this article, POP provides the easiest way to download your e-mail from NYUHome’s e-mail server to the hard drive of your computer, where it can then be stored or saved to external media such as a CD.

The procedure for downloading your e-mail directly to your computer’s hard drive is demonstrated below using Eudora, which is available to most NYU community members on the 2004/2005 NYU-NET CD, as well as from the Software channel within the Files tab of NYUHome (http://home.nyu.edu). Similar procedures employing the POP protocol can be used with the other e-mail clients mentioned above, but the moving, copying, or storage of your e-mail to external media is more complicated. Do not use these instructions with e-mail clients other than Eudora.

Before you begin, be sure to follow all of the computer security guidelines available at: http://www.nyu.edu/its/security/guidelines.html. In particular, be sure that you delete all suspicious e-mail messages and update your Symantec Anti-Virus software before downloading e-mail to your computer.

Figure 1. On Windows, make sure “Leave mail on server” is checked.
Next, you must configure your e-mail client to use POP. Detailed POP configuration instructions for Eudora, Outlook Express, Netscape Messenger, and PC-Pine are available at http://home.nyu.edu/help/mail/mailprograms.nyu. Be sure to reconfigure your e-mail client for IMAP once you complete these instructions.

IMPORTANT NOTE: If you are using Eudora on a PC to download a copy of your e-mail, you must check “Leave mail on server” in the Incoming Mail category of the Options window (see figure 1). This is not included in the instructions on the above website, but when downloading copies of your e-mail, you must check this option or your messages will be deleted from the NYUHome server.

If you are using Eudora on Mac OS X, make sure “Leave on server ___ days” is checked; leaving this option checked with the number of days left blank will ensure your e-mail is left on the NYUHome server (see figure 2).

If you plan to use an e-mail client other than Eudora, check to see if there is an option to leave your e-mail on the server before you download your e-mail. If so, be sure to activate that option. If you don’t, your e-mail may be deleted from the server after you download a copy.

Once Eudora has been configured to use POP, the next time you check your e-mail, Eudora will download all of the messages in your Inbox to your computer’s hard drive. The messages will appear in the “In” mailbox under the “super-folder” called “Eudora”. Please note: If you currently use NYUHome to manage your e-mail and have created additional folders in which to store some of your e-mail messages, you will need to move those messages back into your main Inbox in order to download them to your computer’s hard drive.

Once your e-mail is downloaded to the “In” mailbox it has been saved to your computer’s hard drive. You will now be able to keep it stored in the Eudora folder, move it to another folder on your computer, or copy it to an external disk.

In order to read your e-mail in its proper form, you may need to use the e-mail client you chose to download it with (much as you might need Microsoft Word to view Word documents), or an e-mail client that uses the same mailbox file type. On Windows, Eudora uses .mbx (pronounced dot-m-b-x) mailbox files. Any e-mail client that can read .mbx files will be able to open e-mail that you downloaded with Eudora.

The default e-mail folder that Eudora uses is called “In”, so unless you have created other mailboxes to organize your downloaded mail, the file name where your downloaded e-mail is stored is “In.mbx” (on Windows) or “In” (on Macintosh).

To move your downloaded e-mail to another folder on your computer, or copy it to an external disk for backing up, you will need to first exit Eudora. Next, if you use Windows, perform a search of your computer’s hard drive for “In.mbx” or, if you have used another mailbox, “ThatMailBoxName.mbx.” In Windows 2000/XP, you can perform a search by going to Start and clicking on the “Search” icon. For Windows 98/ME, open the Start menu and click the “Find” icon.

If you use Eudora on a Mac, open the Macintosh HD and perform a search of your local disk for a folder called “Mail Folder” with the search tool on the top right corner of the window. Once you find “Mail Folder”, open the folder to find your desired mailbox. You can then copy it to an external disk or move it to a new folder, as you wish.

To learn more about configuring an e-mail client to download your NYUHome e-mail, including detailed information about the POP and IMAP e-mail protocols, visit http://home.nyu.edu/help/mail/mailprograms.nyu or call the ITS Client Services Center at 1-212-998-3333.

Victor Santana III is a Desktop Support Specialist in ITS Client Services.
Recommended Reading for SPSS & SAS Programmers

By Frank LoPresti
frank.lopresti@nyu.edu

SAS and SPSS are, along with Stata, the most popular statistical packages at NYU. These programming tools allow researchers to analyze and manage data. Additionally, SAS is used by corporations and universities as an all-purpose programming environment to manage their information. Quantitative researchers also use Stata, MiniTab, and S-Plus, along with more exotic special purpose packages such as Lisrel, HLM, and OxMetrics. But most researchers start with SAS and SPSS.

The four books I suggest for SAS and SPSS programmers are:

- **SPSS 12.0 Statistical Procedures Companion**, Marija J. Norusis, SPSS Inc. (referred to in this article as *SPSS Stat Procedures*);
- **SPSS Base 12.0 Syntax Reference Guide**, SPSS Inc. (referred to as *SPSS Syntax*);

Learning SAS or SPSS is like learning how to fly. When you meet your instructor, you can’t say “Don’t show me too much. I just want to fly to New Jersey once.” To simply survive, you must learn navigation, how to take off and land, how to relate to other planes, and so on. To complete a simple analysis in SAS or SPSS, you must have programming and data management skills, and know some statistics. Otherwise you’re probably going to crash and burn.

Along with the skills that make you comfortable managing a dataset, you must also have a sense of the process and where it is going; only then will the analysis progress along fruitful paths. The books described in this article will help you get started.

**SPSS Books**

Norusis’ *SPSS Stat Procedures* would be good subway reading for most researchers, especially for those returning to analysis after a hiatus. The first 100 pages or so take you through the functionality of the various windows used by SPSS, familiarizing you with the “look” of SPSS. In those pages you are also introduced to data preparation through discussions of entering data, sub-setting datasets, eliminating duplicate cases, and missing data concerns. The book goes into enough depth to make you aware of the programming issues that a quick study guide wouldn’t address.

For example, as shown in the figure on p. 24, when introducing recoding (a process which might be used to create a categorical variable with two values [e.g., US Born vs. Foreign Born] from a categorical variable with many values, e.g., Country of Birth), Norusis shows how to check the reasonableness of the result of the recode by running a cross-tabulation of the old variable, Country of Birth, against the new variable, US_born.

Chapter 7, “Testing Hypotheses,” is outstanding and will give the beginning student of research methodology a strong understanding of the reasoning behind the procedures described in later chapters of the book. If you took your last statistics course a couple of years ago, this book is exactly what the doctor ordered.
As a companion book to Norusis, I suggest SPSS Syntax, published by SPSS, Inc. It is important for several reasons. The “Universals” chapter, along with other sections, teaches programming concerns that many researchers never learn. Programming languages share certain core constructs, such as data types, “if” statements, “do” loops, and so on. SPSS Syntax provides the depth of explanation that an intermediate SPSS programmer needs. For example, logical expressions such as “and” and “or” statements and “truth tables” are covered in this book. Although a thorough understanding of these expressions is required for intermediate-level programming, they are often overlooked or avoided by non-programming researchers.

**SAS Books**

Cody and Smith’s *Applied Stats and SAS* is chock full of examples worked through to the results that show the output. The book also includes many problems for the reader to work on and even has an answer section. It concludes with seven chapters that teach SAS programming: how to input data, merge datasets, arrays, character, and numeric functions. These programming constructs are then used in a valuable chapter of example programs, which is followed by a chapter-long syntax guide.

Finally, Delwiche and Slaughter’s *Little SAS Book* demystifies SAS through an inundation of small examples. This 160-page book got me over the hump in my understanding of SAS. Over the years, I was in the habit of going to the wall of SAS manuals we maintain at the ITS Social Science, Statistics & Mapping Group offices at the ITS Third North Lab for advanced SAS programming concerns. SAS, to its credit, has more manuals than the *Little SAS Book* has pages, and by consulting the advanced procedures in these books, I was always able to address my needs for any given SAS procedure.

When I started to teach the introductory SAS classes offered by ITS, however, I read and reread the *Little SAS Book* to get conversant with introductory issues. Through this book’s deluge of short example programs, I came to an understanding of SAS I didn’t have from using advanced procedures or consulting the manuals as the need arose. Inspired by Delwiche and Slaughter’s book, I wrote an article for *Connect* last spring, entitled “SAS for SPSS Programmers”, describing my SAS catharsis (see http://www.nyu.edu/its/pubs/connect/spring03/lopresti_sas.html).

Both Norusis’ book and *Applied Stats and SAS* have chapter after chapter of detailed discussion about a range of statistical procedures, such as frequency, descriptive statistics, regression, repeated measures, and other analysis of variance models. Discussion topics include when a model is appropriate, a look at underlying assumptions, and details of where and what the output shows us. Both books go into detail on the many analysis of variance models, sorting out issues like repeated measures, unbalanced and balanced design, missing data, and interpretation of interactions.

There are hundreds of SAS and SPSS books on the market, quite a few of which I have read. Many offer important contributions to the subject, as they deal with specific statistical areas such as time series or analysis of variance. For beginning and returning analysts, however, I recommend that they start with the four books described here. Please also feel free to contact me to discuss training opportunities at NYU (frank.lopresti@nyu.edu) or visit http://www.nyu.edu/its/classes/ for a list of free ITS classes.

Frank LoPresti heads the ITS Academic Computing Services’ Social Sciences, Statistics & Mapping Group.
This year, the ITS Technology Security Group has seen an enormous increase in the number of phishing scams that have been sent out by e-mail to members of the NYU community. Phishing is a type of e-mail attack, in which a criminal claims to be representing a legitimate company or organization in an attempt to trick the recipient into providing their private information so that it can be used for fraud and identity theft. This type of scam has been relatively successful and is becoming a major problem.

**ANATOMY OF A PHISHING ATTACK**

The typical phishing attack starts with an e-mail in your inbox that appears to be from a company you know and trust. When you click on the link in the e-mail message, you are directed to a “spoofed” (fake) website designed by the criminal that sent the e-mail message (the “phisher”). Once there, you are asked to provide confidential information about yourself (e.g., your credit card number, bank account information, social security number, etc.). After you have entered this information, the phisher can use it to try to gain access to your online bank accounts and steal money, to charge purchases to your credit card(s), and/or to use your identity for illegal activities. In addition, your credit rating may be damaged, which can be difficult and time-consuming to repair.

**WHY PHISHING WORKS**

In a survey conducted by the Gartner group in April 2004 (published in the webcast “Go Phish: Protecting Your Enterprise from E-mail Based Fraud Attacks”), 1.78 million people recalled having given out their personal information when they received a message of this type. This is a staggeringly high number.

There are several reasons why this type of scam is so successful. The criminals who perpetrate phishing scams use certain tactics to help ensure that the messages end up in the inboxes of a large number of their intended victims. They often use a “dictionary attack” against a company to obtain the e-mail addresses of their existing customers. (A dictionary attack is a method of breaking into a password-protected computer system using software that systematically tries every possible password until it discovers the right one.) Once they have the addresses of people who are likely to trust the company they are targeting, the phisher will usually distribute the message as an image file rather than as plain text. This allows the message to slip by many people’s e-mail spam filters, since the filters cannot decipher individual words within the message.

Once the first goal of getting the message into the inbox of a likely victim is achieved, the phisher needs to convince recipients to respond to the message. The primary tactic for achieving this, as you can see from the example in the figure on p. 26, is to use logos and/or the recognizable look and feel of a company or organization in order to gain the recipient’s trust. In the past year, there were phishing scams targeted at the customers of PayPal, AOL, Citibank, Citizens Bank, eBay, and the US Bank; all used the look and feel of the real organization.

The secondary tactic for eliciting a response is to instill fear. In the example in the figure, you will notice that there is a sense of urgency in the statements “this process is mandatory” and “your account may be subject to tem-

---

1. [http://searchsecurity.techtarget.com/webcastRegister/0,295011,sid14_gci999879,00.html](http://searchsecurity.techtarget.com/webcastRegister/0,295011,sid14_gci999879,00.html)
Temporary suspension.” This is a form of “social engineering” (a general term for tricks intended to get people to reveal passwords and other personal information), and an attempt to create a situation in which you will feel the need to comply with the phisher’s request for fear that you might lose your account or break the rules of the institution.

WHAT YOU CAN DO TO PROTECT YOURSELF

The most important thing to remember is that no reputable company will ever ask you for confidential information through an e-mail message. If you receive a message that you are not sure about, the first thing that you should do is call the organization. Use a confirmed telephone number that you find on the back of your bank or credit card or on any paperwork from that company. You can also log into the company’s website the way you normally do (not by clicking on the link in the e-mail), to see if there are any alerts or messages which confirm the content of the message. When in doubt, always err on the side of caution.

If you think that you might be a victim of identity theft, you should immediately request copies of your credit report from the three major credit bureaus. This is something that should also be done on a routine basis once each year. You can contact the bureaus at:

**Equifax**
http://www.equifax.com
1-800-685-1111

**Experian**
http://www.experian.com
1-888-397-3742

**TransUnion**
http://www.transunion.com
1-800-916-8800

If you see any activity on your report that does not look familiar and you believe may be fraudulent, contact the credit bureau immediately to file a fraud alert.

You should also know your rights and stay informed about the scams that are currently circulating. We encourage you to review the following resources:

- [http://www.citibank.com/domain/spoof/learn.htm](http://www.citibank.com/domain/spoof/learn.htm): Information from Citibank regarding phishing of their user’s data.

Tracey Losco is a Network Security Analyst in ITS Communications & Computing Services.
The 2004 Geospatial Summer Symposium

By Antonio Lopez
AnLopez3@NYCT.com

The most significant event of this past summer for the geospatial industry was held at NYU. The first annual Geospatial Summer Symposium was hosted on June 11th, 2004 by NYU’s ITS Social Science, Statistics & Mapping Group, who invited the New York/New Jersey Chapter of the Geospatial Information Technology Association (GITA) to hold the symposium as part of the ongoing ITS Friday GIS Clinic. The symposium, co-sponsored by the ITS Social Science Statistics & Mapping Group, Institute of Civil Infrastructure Systems (ICIS), and GITA, brought together NYU faculty, staff, and students with geospatial technology professionals from across the country.

ABOUT GITA
GITA is a nonprofit international educational association serving the global geospatial technology community. The organization was originally chartered in 1982 under the name of AM/FM International to serve industry professionals with an educational forum for exchanging ideas and keeping up with changes in mapping and facility management technologies. Automated Mapping and Facilities Management (AM/FM) technology is used to automate the mapping process and to manage facilities represented as objects on a map. Utility companies in industries such as gas and electric have historically used AM/FM systems as operations and asset management tools.

These systems were traditionally built using Computer Aided Drafting and Design (CADD) technology, but with the recent integration of CADD into Geographic Information Systems (GIS), the sophistication of facility management technologies has been enhanced. As a result, the application of geospatial technologies has expanded across infrastructure management industries.

In 1998, AM/FM International changed its name to the Geospatial Information & Technology Association (GITA) to better reflect the association’s focus and mission: to provide excellence in education and information exchange on the use and benefits of geospatial information and technology worldwide. The organization is committed to meeting its members’ professional and technical needs by providing a variety of information and references. GITA’s primary goal is to educate current and future geospatial technology professionals on geospatial technologies, applications, organizational challenges, and the contribution and importance of this field to society.

The GITA NY/NJ Chapter was formed in February 2004 by a group of professionals from various backgrounds and levels of experience. This diverse pool of members is committed to geospatial education by working with professionals in the public, private, and academic sectors of the economy, and has extensive experience to offer the NYU community. NYU, for its part, is one of the world’s leading institutions of higher learning and has a world-renowned staff. Its students are tomorrow’s professionals. This summer’s symposium illustrates the commitment that both GITA and NYU have made to education, and the benefits that can be achieved through this type of collaboration.

ORGANIZING THE SYMPOSIUM
Frank LoPresti, Assistant Director of the ITS Social Science, Statistics & Mapping Group and GITA member, invited the GITA NY/NJ Chapter to hold its first summer
symposium as part of his group’s Friday GIS Clinics. These Clinics, which are co-organized by the ITS Social Science, Statistics & Mapping Group, MTA New York City Transit, and Environmental Systems Research Institute (ESRI), are the most recent of his efforts at connecting the NYU community with sophisticated business and government geographic technology users and developers. More information about these Clinics and the ITS/MTA collaboration is available in past issues of this magazine at http://www.nyu.edu/its/pubs/connect/archives/fall02/friday.html and http://www.nyu.edu/its/pubs/connect/archives/fall02/lopez_mta.pdf.

Frank LoPresti has been a pioneer in the field of geographic information technology. In the early 1980s, he was applying GRASS, a GIS developed by the Army Corp. of Engineers, by writing programming code for a hotel site selection application for the Hotel Management School at Cornell University. Under Frank’s direction, the Social Science, Statistics & Mapping Group established several innovative projects, including relationships with Brooklyn Union Gas and a GIS National Science Foundation grant under Dr. Yakov Smotritsky. The GITA symposium presented a new opportunity to bring top GIS professionals from diverse backgrounds to the NYU community, providing a valuable educational service to NYU students and researchers.

Once conceived, Frank and the other GIS Clinic principles, Dr. Zvia Naphtali (Professor of GIS, Statistics, and Data Analysis at the Robert F. Wagner Graduate School of Public Service), Aisha Jenkins (ESRI Representative), and Antonio Lopez (GITA NY/NJ Chapter Secretary and Senior Planner / GIS Analyst at the MTA New York City Transit) began the task of planning the symposium. Antonio Lopez proposed the idea to the GITA NY/NJ Chapter Executive Board, which embraced the possibility. Dr. Rae Zimmerman, director of the Institute of Civil Infrastructure Systems (ICIS) at the Robert F. Wagner School of Public Service was then approached to co-sponsor the event.

A large number of GITA’s members work for civil infrastructure-related organizations in the public and private sectors of the economy, and ICIS’s work in promoting the engagement and collaboration of a wide range of infrastructure-related disciplines and professions complements GITA’s mission. Consequently, Dr. Zimmerman supported the idea of a symposium and with the help of corporate sponsors (AutoDesk, ESRI, MapInfo, Open GIS Consortium (OGC)), the event started to take shape.

THE DAY’S EVENTS
On Friday, June 11th, the sun was out, NYU was in summer session, and approximately 75 geospatial technology professionals gathered for the symposium, a large number of whom work for civil infrastructure-related organizations in the public, private, and academic sectors of the economy. In addition, many volunteers donated their time and effort in making this event a success. These volunteers came from public, private, and academic institutions, including the Geography Department at Hunter College, NYU, MTA New York City Transit, New Jersey Transit, Priceline.com, and private consultants.

The symposium covered a variety of topics recommended by the GITA NY/NJ Chapter members, including homeland security, asset management, critical infrastructure, transportation planning, 3D modeling, Web solutions, CAD/GIS integration, data issues such as interoperability, and more. The symposium offered user presentations, technical workshops, and other sessions geared toward helping GIS and other geospatial technologies professionals succeed in their daily work and toward educating the local geospatial technology community on a variety of topics relevant to geospatial-related professions and society. Many of the sessions offered practical tips from fellow users who have faced and resolved similar challenges.

The symposium was kicked off by the GITA NY/NJ Chapter President, Dr. Rachel Arulraj, who gave an overview of GITA. Mr. Jeff Altofer, President-Elect, then presided over the technical sessions held in the state-of-the-art main lecture room on the first floor of Warren Weaver Hall, while Don Willemann, Chapter Treasurer, chaired the presentations on the building’s 13th floor.

Bob Schultz from KeySpan gave a presentation on the Long Island Power Authority (LIPA)/KeySpan Energy GIS Conversion and Asset Survey Project, discussing the challenges that KeySpan Energy encountered during the conversion from a raster mapping application to a full-featured GIS. In addition, he discussed KeySpan Energy’s ongoing experiences with conducting a full field survey of assets in parallel with the conversion efforts.

Dr. Rae Zimmerman, ICIS Director and symposium co-
sponsor, gave an overview of the Institute’s work and interests in geospatial technologies and GITA. ICIS is part of NYU’s Robert F. Wagner Graduate School of Public Service, in partnership with Cornell University, Polytechnic University of New York, and the University of Southern California, with funding from the National Science Foundation. ICIS (http://www.icisnyu.org) integrates engineering and social sciences so as to comprehensively address the critical problems of developing and managing infrastructure in the 21st century.

GITA National Board of Directors member Brent Jones informed attendees of the many benefits of becoming a GITA member. He elaborated on how the organization does its best to maintain new programs and services, while providing its members with a stable source of important member contacts, industry news, educational opportunities, career resources, and association-related ongoing programs such as the Annual Conference, which is scheduled to take place in March 2005 in Denver, Colorado. GITA is unparalleled in promoting geospatial information technology and the markets it serves.

Mark Reichardt, Executive Director of the Open GIS Consortium (OGC), discussed the progress of OGC members in advancing the implementation of a standards-based plug-and-play infrastructure of geospatial and location-based technologies to improve the sharing and application of geospatial data for government and industry. OGC members have developed a solid framework of standards that are now implemented in the marketplace. These standards-based technologies are now supporting a broad mobilization of spatially enabled applications and tools for a range of uses. He also addressed how local and national government benefits from this framework, and how OGC’s “advancing to the next level” of interoperability will depend on market and user adoption of OpenGIS® specifications within and across organizational systems and enterprises.

A highlight of the GITA Conference was a colorful presentation of New York’s plan for the 2012 Summer Olympic Games by the Brenda Levin, Director of Community Relations for NYC2012 and Vern Bergelin, AICP, Senior Planning Manager of Parsons, Brinckerhoff, Quade & Douglas, Inc. in New York. New York City is one of the five international finalist cities being considered for the Summer Olympic Games, and is preparing its final bid for a decision by the International Olympic Committee in July 2005. The presentation outlined New York’s plan and its advantages and benefits, and illustrated the extensive planning that has gone into the bid. A unique feature has been the use of GIS applications for transportation analysis and image creation in the plan.

A presentation by Doug Eberhard, Chief Technology Officer at Parson Brinckerhoff, focused on emerging technologies for geospatial 3D. Eberhard has 15 years of global experience developing information management and technology solutions. He has led and managed the implementation of innovative IT management and communication solutions on hundreds of projects ranging from small scale planning and engineering studies to large scale construction programs and enterprise technology deployments. He has particular expertise as a solution/business architect and designer for Internet-based project management, content management, project controls, collaboration and communication systems.

Jack Eichenbaum holds a Ph.D. in urban geography and coordi-
nates GISMO, New York City’s Geographic Information System user group. Dr. Eichenbaum works with property data as a City Assessor in the New York City Department of Finance and has published several articles on the location factor in property valuation and the value of municipal data. He also chairs the Public Data Access committee of the New York Area Data Council, teaches the “Geography of NYC” at Hunter College, and is known for his fascinating walking tours throughout New York City. Dr. Eichenbaum spoke of the importance of the GITA NY/NJ Chapter and its role in unifying the GIS users, organizations, and efforts of both states.

Alan Leidner, Consultant and former City of New York Department of Information Technology and Telecommunications Deputy Commissioner of GIS, and Wendy Dorf, Consultant and former GIS Project Manager at the City of New York Department of Environmental Protection (DEP), presented on the evolution of infrastructure data as a component of NYCMap. This highly accurate ortho-map is based upon a mosaic of detailed aerial photographs that have been “geo-rectified” to correct for geometric errors.

The need for the NYCMap came out of Wendy’s initiatives at the DEP to map the city’s water mains. Under the leadership of Alan Leidner, other city agencies joined in on the effort. The map continued to evolve with DEP’s upstate work in support of filtration avoidance, Con Ed’s efforts, and the mapping of infrastructure during the 9/11 disaster. Recent efforts to map sewers, gas mains, and telecommunications infrastructure also aided in this evolution, as have current efforts to map subways and critical buildings. Both speakers stressed the importance of this effort for emergency response and the daily support of government and utility services.

Dr. Zvia Segal Naphtali is a valued member of the GIS community and professor at NYU’s Robert F. Wagner Graduate School of Public Service. She has been teaching GIS and Data Management, Mapping for Health Care Professionals, Survey Research and Analysis, and Statistics courses over the past ten years. She is also the founder and president of Resource Mobilization Inc., a consulting firm established in 1982 that specializes in statistical and demographic data analysis and GIS applications.

Dr. Naphtali gave a fascinating presentation on “Data Issues and GIS” organized around four tasks critical to building GIS applications: accessing, managing, analyzing, and presenting data. The discussion was illustrated by many examples, including Dr. Snow’s 1854 cholera map, the data collection and mapping of the West Nile Virus’ spread, the “My Neighborhood Statistics” on the NYC government website, and the challenges of accessing the US Census 2000 data.

CONCLUSION
In a world where almost 80% of the information managed by business is connected to a specific location, such as an address, street, intersection, or “x, y” coordinate, geospatial technology is finding its way into almost every corner of the business world. Since the uses of geospatial technology are so widespread and diverse, the geospatial market is growing at an annual rate of approximately 35%.

While government has traditionally been the primary user of geographic information technology, the commercial subsection of this market is expanding at a phenomenal rate of 100% each year, according to industry trends compiled by GITA. In such a world, events such as the Geospatial Summer Symposium provide a needed forum for professional organizations and academic and research institutions to collaborate and fortify partnerships.

The ITS Social Science Mapping and Statistics Group, ICIS, and GITA’s NY/NJ Chapter are dedicated to education and the advancement of the geospatial information technology industry. The 2004 Geospatial Summer Symposium was a reflection of what is possible when public, private, and academic organizations work together under the theme of shared knowledge, which is essential for the advancement of industries and individuals and beneficial to society at large.


Antonio Lopez is a Senior Planner and GIS Analyst for the MTA NYCT MetroCard Operations. While earning a Master’s in Urban Planning at NYU, Lopez was a graduate assistant for the Urban Planning Program, and GIS student assistant for the ITS Social Science, Statistics & Mapping Group.
A Basic Guide to Color Management

By Shelly Smith
shelly.smith@nyu.edu

Color management is a technology that helps ensure visually equivalent colors between devices, such as scanners, monitors, and printers, making it possible, for example, for an RGB scan viewed on an RGB monitor to happily match a CMYK print of the same image. The goal of color management is to establish reliability, predictability, and consistency of color when transferring or reproducing any image—a process that can often present many challenges.

The following information has been collected and organized as a beginners’ guide to basic color management concepts. Adobe Photoshop is used in examples throughout this guide because of its value and range of capabilities as an image processing and color management package.

GLOSSARY OF GENERAL COLOR MANAGEMENT TERMS

> Calibration
The process of adjusting specific devices to ensure that they produce the most accurate color possible. Can involve monitor adjustments and/or the use of external hardware to precisely measure the output of a monitor’s phosphors and the density of ink on a page. Calibration is intended to make a device produce colors that are as close as possible to an objective standard.

> CIE
The International Commission on Illumination (http://www.cie.co.at). Founded in 1920, CIE is an authority on lighting and is recognized by ISO, the International Standards Organization. The International Standardization body developed a way to assign numbers to every color visible to the human eye: CIE L*a*b.

> Color Management Module (CMM)
Software that translates color information from one profile to another. Adobe Color Engine (ACE) is an example of a CMM.

> Color Management System (CMS)
A collection of color engines, ICC profiles, color settings, and other bits and pieces to manage color. A set CMS applies Apple’s ColorSync or chosen custom profiles specific to the devices used (e.g., monitors, printers, scanners). Apple’s ColorSync or Microsoft ICM for Windows are system-level color management systems. Kodak CMS is a program-level CMS.

> CMYK Profile (In Photoshop’s Color Settings)
A profile which identifies to the color management engine the capabilities of a specific output, press, or print device. Profiles for inkjet printers that require RGB images are also loaded as CMYK profiles. The CMYK profile determines the CMYK working space.

> Color Management Engine (Color Engine)
Software that serves as a translator between devices, mapping color from one device profile to another. The color engine reads color data in a file and color profile for any monitor, and converts the colors to the color space of another device, for example:
- Monitor > Color Engine (mapping translation) > Printer
- Foreign Computer File > Color Engine (mapping translation) > Printer

> Color Management Policies (In Photoshop’s Color Settings)
These options determine what Photoshop does when you open a file with an embedded profile that doesn’t match your working space. The embedded profile can be retained, which may result in an inaccurate appearance on screen. Otherwise, you can convert to a
working profile or simply ignore the profiles altogether.

> Color Mapping
Translating color information from one profile to another. A color engine looks at an image's color data, takes into account the source profile embedded in the file, and then maps color information to the destination profile.

> Color Model
A system of notation used to numerically describe the specific colors within a gamut. RGB, CMYK, Grayscale, L*a*b and HSB are examples of color models.

> Color Settings
A term that refers to both the options you've selected for color management and the Photoshop dialog box.

> Color Space
The collection of possible colors that can be created by a specific technique or device. In Photoshop, L*a*b space has the widest theoretical color space, encompassing all the colors that the human eye can see. RGB space is produced by mixing red, green, and blue light. CMYK color space includes only those colors created by using the four process color inks (Cyan, Magenta, Yellow, and Black). Color space is restricted by the capabilities of the specific devices being used.

> Embedded Profile
A profile that is created when a file contains information about the devices with which or for which the file was prepared. RGB or CMYK profiles are embedded into the file itself—the document is tagged. When the file is opened or output, a color management engine reads the embedded profile(s) and applies the color management policies, either converting the image's colors to the working space or not. ICC-aware file formats (PSD, TIFF, EPS) give the option of embedding a profile in the “Save As” window. Profiles can be changed in Photoshop as follows:

  Image > Mode > Assign Profile or Convert Profile

> Gamut
The collection of colors that can be reproduced by a monitor or printer for a particular color model (e.g., RGB, CMYK, L*a*b).

> International Color Consortium (ICC)
The ICC (http://www.color.org) was founded in 1993 by eight companies: Apple, Microsoft, Agfa, Adobe, Kodak, and others. Their intent was to establish a system to standardize color from computer to computer, program to program, or printer to printer. The ICC file format was developed as a way to store and provide access to information about a specific device's capabilities.

> ICC Profile
A type of file (.icc for Macintosh and .icm for Windows) that records device-specific information for a monitor, printer, or scanner profile. ICC profiles are loaded into Photoshop's Color Settings dialog box as Working Spaces.

> L*a*b
The CIE L*a*b color model.

> Profiling
After a device is calibrated, it is then profiled. Also called characterizing, this process records how close a device comes to matching an objective standard for color reproduction. This record becomes the device's ICC profile. Calibration, as the first step, adjusts a device to as close a match as possible, then profiling measures any shortfalls in the calibration. Adobe Gamma control panel adjusts and profiles a monitor instead of calibrating it. Third party hardware/software products often calibrate using the same procedure.

> RGB Profile (In Photoshop's Color Settings)
The gamut that a monitor is capable of reproducing, along with vagaries in performance, is recorded as the RGB profile. This profile is used by the color engine.

> Working Space
The gamut of an image's color model, which is restricted by the device profile. CMYK images have a working space defined by a CMYK profile. RGB images are defined by an RGB profile.

**Color Management Process**

Color management can be considered a system of compensating for the individual characteristics of devices so as to produce uniform color. This often entails making corrections based on best guesses or trial and error—aiming for a target and eventually hitting it.

In terms of process, color management revolves around a color management system (CMS). The CMS is based on the color engine, software that actually translates one set of color values to another. The engine uses color profiles embedded in an image file that describe how a particular piece of hardware reproduces color. When a profile is applied to the image, color values are skewed for the particular characteristics of the specific device. When color values need to be prepared for output to different devices, the engine translates the colors so that they appear as consistent as possible in the final product.

**Example of a Problem:**
Monitor with a blue cast that negatively affects the colors on the screen (due to settings or the general age of the hardware).
Possible Solutions:
• Calibrate or adjust monitor to show most accurate color onscreen.
• “Characterize” the monitor by creating a profile with RGB settings. Added color is assured to be the same hue and tint as onscreen output.
• In preparation for commercial printing, the color in question should be considered as to whether it can be reproduced by print service’s inks and paper. An appropriate CMYK setting or profile may be needed for the print job. RGB can display colors on the monitor that are out of gamut, meaning that they cannot be output on press. Color engines will handle the translation to colors within the gamut range. Colors are then translated to the CMYK color space.
• Clip colors to remove suspect colors from an image, avoiding out of gamut range completely.
• Alternately, suspect colors can be brought into a printable color space by two systems: Perceptual or Relative. In a Perceptual system, color is shifted from RGB to match as closely as possible the CMYK equivalent. In a Relative system, color is compressed into the single nearest printable color.

WORK ENVIRONMENT
The most important detail or step in any color management system is to ensure that the onscreen color is as exact a match as possible to the colors recorded in an image file.
1. Control ambient lighting when doing color correction. Too little ambient light isn’t ergonomically practical and too much competes with the monitor. Shield the monitor from ambient light with a hood device. Shield the top and sides of the monitor to a distance of 12”. The inside of the hood should be matte black; this can be a commercial hood or homemade device.
2. Computer desktop should be as neutral as possible; gray or black are best.
3. In Photoshop, press the F key to toggle through the available Screen Modes for viewing an image file.
4. Remove other objects from on or around the monitor (e.g. files on the desktop, post-it notes on the monitor).
5. The visible walls around the monitor should be as neutral as possible; gray is recommended.

SYSTEM LEVEL COLOR MANAGEMENT
> Macintosh
The System Preferences for Mac OS X ColorSync can specify ICC profiles. Photoshop defaults to these profiles when launched. Profiles can later be changed within Photoshop on a document-by-document basis, if desired. ColorSync can also specify a Color Management Module or CMM to handle all color conversion. Document profiles will tell ColorSync (and programs that use a CMS) how to handle images without embedded profiles.
> Windows
The Windows CMS is called Image Color Management (ICM). This is a component of Windows designed to work with ICM-aware programs and devices to standardize color not used directly from Photoshop. Other ICM-aware programs can be set to use ICM by selecting:
File > Color Management

CALIBRATING THE MONITOR
Third party calibration hardware is recommended for prepress professionals, artists, photographers, or general Photoshop users that need to rely on color accuracy. If you generally output to a home or office printer or a monitor for web publishing, however, third party hardware is probably not necessary.

Monitors can be adjusted by making a profile and saving it in a known location, named in a meaningful manner with the monitor’s name and date (Macintosh profiles should be named with a .icc extension and Windows profiles should be named with a .icm extension).
> Adobe Gamma Profiling
Photoshop automatically installs an Adobe Gamma control panel that allows you to create a custom monitor profile. The panel is accessible in Windows by selecting:
Start > Settings > Control Panel
In Mac OS 9, select:
Apple Menu > Control Panels > Adobe Gamma
Adobe Gamma is not compatible with Mac OS X, so a display calibration program is used instead:
System Preferences > Displays > Color Tab > Calibration Button
The Calibration Button activates the “Display Calibrator Assistant”, which is a wizard program that walks you through the process of creating monitor profiles. Expert Mode turns on all of the available options.

PHOTOSHOP’S COLOR SETTINGS
The first time you launch an image file in Photoshop, a window opens that gives you the option of customizing the color settings. If you choose “yes”, the Color Settings window will open. If you choose “no”, Photoshop will load colors appropriate for a web-safe palette.

To access the Color Settings at any time in Windows or Mac OS 9, select: Edit > Color Settings
In Mac OS X select:
Photoshop > Color Settings
In Adobe Photoshop 7.0, color settings are stored in the Settings Folder. Deleting a profile restores the file to the default settings. The Settings Folder is accessed through the Color Settings window by clicking the “Load…” or “Save…” buttons.

> The Settings Menu
The Settings pop-up menu at the top of the window is a list of preset packages of color settings. Choosing a package automatically configures the remaining options in the window. You can also create a custom package through the Settings menu.

> RGB Working Space
The selections made in the RGB working space area completely define the RGB working space, and color profiles embedded in an RGB image space include the settings defined here. For a well-calibrated production environment, Adobe RGB is the recommended official RGB profile. Radius Pressview Monitors should use ColorMatch RGB. Wide-gamut dye sublimation printers or photo-quality printer operations should use ProPhoto RGB. Keep in mind that service bureaus may prefer one specific gamut over another.

Photoshop users outputting to inkjet printers and web designers are best served by using custom monitor profiles created with Adobe Gamma or another such calibration/profiling procedure. The profile is then geared for monitor display with resulting accurate onscreen color. Monitors profiled with Adobe Gamma have a custom profile available in the RGB menu.

> CMYK Working Space
Proper CMYK profiles are necessary even for basic inkjet printing. Printers handle RGB color data from images, but are CMYK devices at their foundation. Many inkjet printers with accompanying software install ICC profiles for combinations of resolution and paper quality. Service bureaus can also help you customize a profile for a specific printing process. To load a custom CMYK profile, in the Working Spaces section of the Color Setting window, select: CMYK > Custom CMYK > Desired Profile

If you are not working with a custom profile, choose the stock profile that best fits your needs. If you are unsure of which profile to choose, you may want to start with “Generic CMYK”.

> Gray Working Space
Gray working space settings only affect the onscreen appearance of grayscale images. The Gray working space enables you to see the dot gain or gamma on an image. Print prepress traditionally uses a dot gain of 20%, while web professionals are best served by a gamma of 2.2.

> Spot
The default dot gain setting for Spot channels is also 20%. Dot gain refers to the amount of spread for the “dot” or drop of ink on a given paper stock. Coated papers (gloss) produce little dot gain. Uncoated papers absorb more ink and consequently produce more spreading or dot gain. Dot gain settings compensate for the amount of spread by reducing the size of each ink dot.

> Mismatch Notification
When opening a file, this important
tool lists the profiles involved in a given file and gives you the opportunity to evaluate the situation and choose whether to save the embedded profile, convert the working space, or discard the profile. Activate this tool by checking the Profile Mismatches > Ask When Opening option in the Color Management Policies section of the Color Settings window. You should uncheck this option when batch processing large numbers of images that must be handled in the same manner.

> Color Engine
Under Conversion Options, choose your preferred color engine. All of the available engines do a good job of converting color from one profile to another, but Adobe ACE is the usual choice. Mac users also have the option of using ColorSync or Apple CMM, and Windows offers Windows ICM engine.

> Intent
Also under Conversion Options, this setting determines how the color engine deals with colors that fall outside the destination gamut. Intent settings come into play primarily when converting from a larger to a smaller gamut. For example, converting from sRGB (small) to Adobe RGB (large) won't result in a visual shift since the range of color is increased, but converting from Adobe RGB to a CMYK gamut will result in shifting. The color engine uses the Intent setting to determine how it handles these translations:

- **Perceptual**: Results of color conversion are as close as possible to the original according to the human eye. If the source gamut is larger than the destination gamut, all colors are shifted. Use Perceptual when you want to maintain the image's overall appearance and don't need to retain any specific colors within image.
- **Saturation**: Colors out of destination gamut retain saturation values and are brought into gamut by adjusting lightness and hue. This works best for highly saturated work, such as clipart, graphics, or logos.
- **Relative Colorimetric**: Colors reproducible in the destination gamut are unchanged. Colors falling outside the new gamut are brought into gamut by adjusting hue and saturation. Only colors on the fringe of the gamut are affected, and they maintain their lightness values. This preserves the image's overall tonality, and because the human eye is far more sensitive to tonal changes than changes in hue, this option is the best choice for most images.
- **Absolute Colorimetric**: The absolute L*a*b coordinates of source colors are mapped to a destination gamut without regard for white point mapping and can result in unusual color shifts. You can use Absolute Colorimetric for one- or two-color graphics, but it isn't appropriate for continuous tone photographic images.

> Black Point Compensation
When selected, this setting maps the darkest neutral pixels in the source gamut to the same in the target gamut. When unchecked, neutral shadows are mapped to black. When converting from RGB to CMYK, this setting should be selected.

> Monitor Dithering
Dithering during conversion can increase file size but can also reduce visible banding in continuous tone images where too many colors are mapped to too few in the destination gamut.

> Desaturating Monitor Colors
If activated, this setting enables you to see more detail in the highlighted areas in large RGB spaces like Adobe RGB. This option should only be selected when working with strong highlight images or if part of the gamut is not portrayed onscreen.

> Blend RGB Colors Using a Different Gamma
This setting can be used to reduce artifacts along distinct edges of an image. By default, Photoshop uses the assigned monitor gamma to blend RGB values onscreen. Increasing or decreasing this option can help to smooth artifacts.

> Loading and Saving Color Settings
After configuring the appropriate Color Settings, click Save... You will be able to use the Load... button to access these settings at a later date, as needed.

> Changing Embedded Profiles
Embedded profiles can be changed in a variety of ways. They can be converted upon the opening of a file; modified with the color mode of a document; and stripped from the image by selecting “Discard the Embedded Profile” when you are notified of a mismatch.

To do any of the following, select Image > Mode > Assign Profile:

- Strip the embedded profile from the document.
- Tag document with working profile (RGB, CMYK and Grayscale).
- Choose another profile of the appropriate color mode.

Assigning a new working space does not change the color values in the image; rather, it embeds a new profile in the document and shows you onscreen what the image will look like in that gamut.
The preview option enables you to view the result before assigning the changes to the file.

To convert the embedded profile, select: Image > Convert > Profile.

This option does change the color values; the image’s colors are mapped from an embedded profile to a selected profile. Options selected in this window override those in Color Settings. The Convert command attempts to maintain the appearance as closely as possible when remapping.

**SOFT PROOFING IN PHOTOSHOP**

Select View > Proof Setup to make a proof selection for onscreen viewing from a selection of profiles, including CMYK, individual color channels, or RGB gamuts. Use the “Custom” option from the View > Proof Setup menu to view how the image would look with any available profile. Two additional options for Simulate Paper White and Simulate Ink Black are available. These options attempt to display onscreen the physical characteristics of paper and black information recorded in the profile.

Select View > Proof Colors to preview images on screen but not as a substitute for the actual printed proof. Hard proofs are the best way to color correct. Proof Colors is best used to view how RGB images will convert to the selected CMYK working space.

For a side-by-side comparison of the effects of different profiles on the image, select Window > Documents > New Window. Choosing an individual CMYK working plate for proofing is comparable to converting a document to CMYK and viewing a single channel in the Channels palette.

### SPECIAL NOTES

The filename in the Image window indicates whether a profile is embedded in the image or if there is a profile mismatch between image and working space. If an asterisk (*) appears after the color mode in the title bar, there is a profile mismatch. When a pound (#) sign appears, the image is not color managed and no profile is embedded.

Any color management system’s responsibility is the accurate reproduction of color. If an image contains color casts or other color issues, proper color management won’t correct the problems. Color management is not a substitute for color corrections or adjustment functions.

### COLOR MANAGEMENT LINKS

Consult these helpful online color management resources for additional information:

- **Apple**
  - Apple Main Website: [http://www.apple.com](http://www.apple.com)

- **CMS**
  - Aurelon: [http://www.aurelon.com](http://www.aurelon.com)
  - CHROMIX ColorThink: [http://www.chromix.com/colorthink/?PID=1](http://www.chromix.com/colorthink/?PID=1)
  - ColorBlind: [http://www.color.com](http://www.color.com)
  - ColorVision: [http://www.colorvision.com](http://www.colorvision.com)
  - ColorWizzard: [http://www.colorwizzard.com](http://www.colorwizzard.com)
  - Datacolor Spectrophotometer Products: [http://www.datacolor.com/products_instruments_list.jsp](http://www.datacolor.com/products_instruments_list.jsp)
  - FUGIFILM ColourKit: [http://www.colorprofiling.com](http://www.colorprofiling.com)

- **GretagMacbeth**: [http://www.gretagmacbeth.com](http://www.gretagmacbeth.com)
- **Praxisoft**: [http://www.praxisoft.com](http://www.praxisoft.com)
- **Rods and Cones**: [http://www.rodsandcones.com](http://www.rodsandcones.com)
- **X-Rite**: [http://www.xrite.com](http://www.xrite.com)

**General Concepts & Resources**


- **CIE**: [http://www.cie.co.at](http://www.cie.co.at)
- **Color Remedies**: [http://www.colorremedies.com](http://www.colorremedies.com)
- **Kodak**: [http://www.kodak.com](http://www.kodak.com)
- **ColorBlind**: [http://www.color.com](http://www.color.com)
- **ColorVision**: [http://www.colorvision.com](http://www.colorvision.com)
- **ColorWizzard**: [http://www.colorwizzard.com](http://www.colorwizzard.com)
- **Datacolor Spectrophotometer Products**: [http://www.datacolor.com/products_instruments_list.jsp](http://www.datacolor.com/products_instruments_list.jsp)
- **FUGIFILM ColourKit**: [http://www.colorprofiling.com](http://www.colorprofiling.com)
- **GretagMacbeth**: [http://www.gretagmacbeth.com](http://www.gretagmacbeth.com)
- **Praxisoft**: [http://www.praxisoft.com](http://www.praxisoft.com)
- **Rods and Cones**: [http://www.rodsandcones.com](http://www.rodsandcones.com)
- **X-Rite**: [http://www.xrite.com](http://www.xrite.com)

> **International Color Consortium (ICC)**

- **ICC Main Website**: [http://www.color.org](http://www.color.org)
- **ICC Profile Information**: [http://www.color.org/wpaper2.html](http://www.color.org/wpaper2.html)

---

Shelly J. Smith is a Senior Arts Technologist with the Arts Technology Group in ITS Academic Computing Services.
Technology in the ITS Multimedia Classroom

By Robyn Berland, with Robert Whelan
robyn.berland@nyu.edu; robert.whelan@nyu.edu

Scenario I: Professor Art Digitalus

Let’s say there’s a Professor Art Digitalus who teaches a weekly digital tools class in the ITS Multimedia Lab classroom. Each of his students is seated at a Macintosh G5 computer with a 17” flat panel display, arranged around three sides of a 20’ x 50’ room. The instructor’s station stands on the fourth side of the room and includes a rear-projection interactive white board—a SMARTBoard 3000i by Smart Technologies. The SMARTBoard consists of a 66” screen, an integrated XGA projector capable of projecting a 1024 x 768 ppi (pixels per inch) image, and an audio system.

Housed within the SMARTBoard cabinet is a Macintosh G5 networked computer, a VCR with access to NYU-TV, a DVD Player, and a DV Deck. Visitors’ laptops can also be connected, as needed. At times, Art even controls the computer using a Bluetooth wireless mouse and keyboard. Since these devices do not depend on line of sight, Art can position himself anywhere in the room, or even hand over the controls to students who are eager to demonstrate a point.

Most often, however, Art positions himself by the SMARTBoard, using the touch-screen to launch applications, draw and manipulate images, browse the Web, drag and drop files, and so on. He also uses the SMARTBoard’s colored pens (with electronic ink) to annotate files and clarify his lesson. There is even an eraser. The SMARTBoard also comes with a suite of software tools including an electronic keyboard—most often used if the real keyboard has been misplaced in the classroom—and a SMART Notebook with which Art captures his presentation, along with all of his in-class annotations.

To manage the computers in the Multimedia Lab classroom, Art uses Apple’s Remote Desktop Administration application. Remote Desktop is a classroom management tool that works on both wired and wireless networks, and on Macintosh, UNIX, and Windows computers (VNC compatible). Remote Desktop has been configured to display the computers in the classroom as a discrete group. Remote Desktop Client software is installed on every computer as part of the Macintosh OS 10.3 operating system. It is the client application that controls access privileges to the computer. As an instructor, Art is only able to perform classroom management tasks, but Remote Desktop is also used by ITS staff as a lab management tool.

Let’s suppose that Art will begin today’s class with a review and discussion of his students’ work from the previous week, when they were introduced to concepts of composition. In that class, students scanned photographs and printed material of their choosing, using flatbed scanners located in the classroom. They also downloaded images and other material from the Web. Using Adobe Photoshop, the students combined and manipulated these elements to create an original work. Today, Art begins the review process...
by asking a student to open her Adobe Photoshop file on her computer and describe her work. Using Remote Desktop, Art displays her image on the SMARTBoard. Art and the student’s fellow classmates critique the compositional elements of the image. Art captures the discussion in annotations on the screen and then captures the image using the SMARTBoard screen capture tool. He then asks the student to keep her image active on her screen while he moves on to the next student.

Art decides that a comparison between two of the students’ images would be interesting, so he displays their work side-by-side, capturing the classes’ comments on the SMARTBoard as they discuss them. By the time all 25 students have shown their work, Art has all of the images displayed on the SMARTBoard, where he can zoom in on specific images as they come up in conversation.

After a short break, Art changes the topic of discussion to typography, showing the students the sample typefaces he has brought in, along with a variety of web resources. While he is teaching, Art locks the students’ computers using Remote Desktop so that their attention will not be diverted. He demonstrates the Photoshop tools that the students will need to complete their classroom assignment, capturing his board work as he teaches. He then unlocks the students’ computers, saves the notes from his presentation as a PDF, then uses Remote Desktop to distribute the file to each student’s computer, along with a copy of each student’s work with annotations from the review at the beginning of the class.

As the students work on their classroom assignment, Art uses Remote Desktop to observe their progress. He uses the chat feature to ask one student if he needs help. The student explains his confusion, and Art asks if he can take remote control of the student’s computer for a moment to walk him through the procedure. Another student initiates a chat with Art, raising an interesting point about the assignment. Art, realizing that her point may be of interest to other students, sends a message to the entire class, asking them to look at her work on the SMARTBoard while she shares her question. At the end of class, Art announces that he has saved the SMARTBoard Notebook presentation as HTML, and that it will be available to the students through their Blackboard course site.

**SCENARIO II: PROFESSOR PAT PIXLEY**

As an instructor working with, and teaching, media and technology-based educational theory and practical skills, Prof. Pat Pixley (aka Robert Whelan) finds the ITS Multimedia Classroom’s SMARTBoard especially useful.

For Pat, SMARTBoard’s easy-to-use, touch-sensitive full-size interactive whiteboard allows him to present, create, and collaborate in the classroom. Because it is connected to a computer, he controls applications directly from the whiteboard with the touch of his finger, writes notes onscreen in digital ink, and saves his work to share later in a variety of formats. For the lecture portion of his class, Pat uses the SMARTBoard to display slide presentations, which he navigates simply by tapping lightly on the screen. Some slides include active hyperlinks which, when touched, launch a website related to a topic or concept being discussed in the slides.

Pat uses the SMARTBoard to demonstrate a wide range of
software tools, such as Microsoft PowerPoint and Word. He also opens the SMARTBoard Notepad and enlarges the text size to demonstrate basic coding in HTML, saves the .txt file and then opens it in a web browser. Pat uses Dreamweaver to show students how to create web pages, add content, and upload to the Web via FTP.

SMARTBoard also has a very useful feature for supporting students who are learning procedure-driven or linear skills, such as software use. This feature allows Pat to take a screenshot at any given point in a demonstration, building up a small ‘library’ of screenshots which can then be exported to a simple web page—or website—and uploaded to Blackboard or to another course website. This screenshot-to-website feature means that students can revisit Pat’s demonstration, and reflect on the steps in a process in a way that uniquely reflects their classroom experience. This highly visual feature is far superior to handouts or worked examples, and easy for Pat to master.

Pat also finds SMARTBoard particularly useful for non-textual interaction. For example, when demonstrating the web animation package Flash, he makes a short animation of a beating heart to demonstrate the basic principles and applications of Flash for educators. The Flash demo shows his students how to create symbols, import images to the library, drag them onto the stage, and add keyframes and tweens. Since his animation has no text, Pat doesn’t use the keyboard at all, just his fingers on the “canvas” of the SMARTBoard. Both he and his students are impressed with the versatility and convenience of this tool.

The ITS Multimedia Lab offers faculty training on the SMARTBoard by arrangement. With a little imagination, you too can use the features of the SMARTBoard in impressive ways that will undoubtedly become an essential part of your classroom practice. To learn more, please send e-mail to robyn.berland@nyu.edu.

Robyn Berland is the Computer Lab Manager of the ITS Multimedia Lab; Robert Whelan teaches a course in instructional design for the Web and works at the ITS Faculty Technology Center.
NYU Partners on $5.2 Million in Awards from the Library of Congress

By David Ackerman
david.ackerman@nyu.edu

NATIONAL DIGITAL INFORMATION INFRASTRUCTURE & PRESERVATION PROGRAM

In December 2000, Congress authorized the Library of Congress to develop and execute a plan for a National Digital Information Infrastructure and Preservation Program (NDIIPP). A $99.8 million congressional appropriation was made to establish the program.

The overall plan sets forth a strategy for the Library of Congress, in collaboration with other federal and non-federal entities, to identify a national network of libraries and other organizations with responsibilities for collecting digital materials, providing access to and maintaining those materials, and setting forth policies, protocols, and strategies for their long-term preservation.

To further this plan, on September 30, 2004, the Library of Congress made awards totaling more than $14.9 million to eight projects dedicated to identifying, collecting, and preserving digital materials within a nationwide digital preservation infrastructure. The institutions collaborating on these projects will share responsibilities for preserving at-risk digital materials of significant cultural and historical value to the nation.

New York University is a partner on two of the selected projects: a $2.8 million grant to the Education Broadcasting Corporation (Thirteen/WNET New York) and its partners, WGBH (Boston, MA), Public Broadcasting Service (PBS, Alexandria, VA), and NYU; and a $2.4 million grant to the University of California's California Digital Library (CDL) and its project partners, University of North Texas (UNT) and NYU.

PRESERVING DIGITAL PUBLIC TELEVISION

Partners in the project to preserve digital public television (Thirteen, WGBH, PBS, and NYU) will collaborate to establish the first procedures, spread the word, and set the standards. NYU is working with the other project partners to curate digital television content and develop the necessary conservation protocols and procedures.

The NDIIPP website: http://www.digitalpreservation.gov/
structures, and national standards necessary to preserve public television programs produced in digital formats.

Thirteen and WGBH are the two largest producers of public television content in the United States. Through PBS, their productions are made available to audiences from coast-to-coast. Together, these three entities produce and distribute the majority of public television in the United States. NYU, for its part, is home to one of America’s most distinguished research libraries and has become a major player in the field of digital preservation of moving images.

The four partners will focus on such influential series as “Nature,” “American Masters,” “NOVA,” and “Frontline,” which increasingly are being produced in digital formats, including the new high-definition standard (HDTV). Issues associated with the preservation of important corollary content, such as websites that accompany broadcasts, will also be examined.

NYU’s participation in this initiative will be led by Dr. Howard Besser, Director of the Tisch School of the Arts Moving Image Archiving & Preservation Program, and Dr. Jerome McDonough, Manager of NYU Digital Library Development (see sidebar). McDonough is also the leader of Metadata Encoding & Transmission Standard (METS), an international effort to establish a standard for encoding descriptive, administrative, and structural metadata regarding objects within a digital library.1 Besser has published and worked internationally on issues relating to digital longevity.

**The Web at Risk**

Partners in this project—CDL, UNT, and NYU—will develop web archiving tools that libraries can use to capture, curate, and preserve collections of web-based government and political information. The archives that will be built, using tools developed to capture these materials, will focus on political activities and movements such as the California gubernatorial recall election of 2003.

At NYU, The Tamiment Library and Robert F. Wagner Labor Archives form a unique, internationally-known center for scholarly research on labor and radical politics. Our curatorial expertise in this area, led by Michael Nash, should prove invaluable to this project.

Leslie Myrick, Digital Library Programmer/Analyst for the NYU Digital Library Team, will lead the technical work at NYU, in coordination with CDL, as well as provide the overall project coordination.

Since its founding in 1963, NYU’s Tamiment Library has been dedicated to collecting and archiving the ephemeral literature produced by American radical and labor organizations. Such literature, which traditionally took the form of pamphlets, leaflets, and posters, is now largely web-based, and therefore increasingly endangered. Just as so many of the pamphlets and flyers of these organizations have survived only in the Tamiment Library’s vertical files, the Library must now find ways to preserve web-based literature that documents the history of these organizations for future generations.

---

NYURoam Wireless

Now available at even more campus locations!

For more information, including instructions on how to start using the NYURoam wireless access service and a detailed list of campus access locations, please visit the ITS website: http://www.nyu.edu/its/wireless/

Please note: Some NYURoam wireless access locations are located in residence halls or administrative areas with restricted access. Please check our website for details.